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Computers provide an interface to the world for many individuals with disabilities and 

without effective computer access, quality of life may be severely diminished. As a result of this 

dependence, optimal human computer interaction (HCI) between a user and their computer is of 

paramount importance. Optimal HCI for individuals with disabilities relies on both the existence 

of products which provide the desired functionality and the selection of appropriate products and 

training methods for a given individual. From a product availability standpoint, optimal HCI 

often depends on modeling techniques used during the development process to evaluate a design, 

assess usability and predict performance. Computer access evaluations are often too brief in 

duration and depend on the products present at the site of the evaluation. Models could assist 

clinicians in dealing with the problems of limited time with clients, limited products for the client 

to trial, and the seemingly unlimited system configurations available with many potential 

solutions. Current HCI modeling techniques have been developed and applied to the 

performance of able-bodied individuals. Research concerning modeling performance for 

individuals with disabilities has been limited. This study explores HCI as it applies to both able-

bodied and individuals with disabilities. Eleven participants (5 able-bodied / 6 with disabilities) 

were recruited and asked to transcribe sentences presented by a text entry interface supporting 

word prediction with the use of an on-screen keyboard while time stamped keystroke and eye 

fixation data was collected. Data was examined to identify sequences of behavior, performance 
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changes based on experience, and performance differences between able-bodied and participants 

with disabilities. The feasibility of creating models based on the collected data was explored. A 

modeling technique must support selection from multiple sequences of behavior to perform a 

particular type of action and variation in execution time for primitive operations in addition to 

handling errors. The primary contributions made by this study were knowledge gained relative to 

the design of the test bench and experimental protocol.   
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Table 1. Acronyms and abbreviations 

AB able-bodied participants 
AT assistive technology 
CP Cerebral Palsy 
DQW ISCAN Raw Eye Movement Data Acquisition Software 
FIX keystroke event to fix an error - backspace 
GOMS goals, operators, methods and selection rules 
HCI human computer interaction 
HIP human information processing 
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IT information technology 
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KW fixation on keyboard followed by a fixation on the word prediction list 
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MHP model human processor 
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T transcribed text 
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TP fixation on transcribed text followed by a fixation on the presented text 
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WP word prediction typing condition 
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text 
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1.0  INTRODUCTION 

Computers are a vital component in the lives of many people today, yet their potential to 

revolutionize the lives of others remains untapped. A variety of factors such as limited income, 

physical impairments, and a fear of technology all contribute to the Digital Divide. Statistics 

based on the Computer and Internet Use supplement to the Current Population Survey from 1998 

show that people with disabilities are less than half as likely to have access to computers at home 

and less than one third as likely to have Internet access at home than non-disabled individuals 

(1). An analysis based on the Computer and Internet Use Supplement to the Current Population 

Survey from 2003 shows that while over half of the able-bodied respondents use a computer at 

home less than one third of the individuals with disabilities do so (2). Controlling for the 

presence of a computer in the home shows that individuals with disabilities are 10% less likely to 

use the computer than able bodied individuals suggesting the presence of a Disability Divide.   

Computer access can be a gateway to the world, providing a vast array of services 

including communication with family and friends, employment, education, banking, paying bills 

and shopping. This is all in addition to providing the ability to access an unlimited amount of 

information related to virtually any topic imaginable. Dobransky and Hargittai (2) provide an 

extensive review of studies examining disability and access to IT (information technology). 

Identified benefits of access to IT are both psychological and physical with increases found in 
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self esteem, independence and health related outcomes. Identified barriers to IT access include 

cost, support, and assistive technology in regards to availability and performance.   

While programs are being initiated to provide computers and basic computer literacy 

training to individuals with disabilities (3), accessibility issues related to assistive technology 

remain a barrier. Availability, appropriate selection, cost, and training all provide challenges for 

individuals needing assistive technology. Many individuals using assistive technology for 

computer access are left fatigued and frustrated.      

Computers provide an interface to the world for many individuals with disabilities and 

without effective access, quality of life may be severely diminished. As a result of this 

dependence, optimal human computer interaction (HCI) between a user and their computer is of 

paramount importance. Optimal HCI for individuals with disabilities is dependent on both the 

existence of products which support or augment the individual’s abilities and the selection of 

appropriate products for that individual.       

1.1 PRODUCT DEVELOPMENT 

From a product availability standpoint, optimal HCI often depends on modeling techniques used 

during the development process to evaluate a design, assess usability and predict performance. 

Unfortunately, current HCI models are calibrated exclusively on able-bodied individuals and the 

effect of disability on these models is neither understood nor considered (4, 5). 

Assistive technology (AT) is applied to computer access with the intention of 

compensating for physical limitations experienced by the user. Solutions allow the user to 

interact with the system but they are often less than ideal and may not fully exploit the 
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capabilities of the individual due to a general lack of knowledge of HCI as it relates to disabled 

persons.   

Additionally, while Section 508 of the Rehabilitation Act mandates equal access to 

electronic and information technologies for government employees and recipients of government 

funds, accordance and enforcement of the law are problematic due to incomplete guidelines (6). 

AT is typically applied to provide access to existing products developed for able-bodied users; as 

a result, disabled users will often be limited to some extent by the original product design. AT is 

often developed or modified in response to the release of products developed for an able bodied 

user group, creating a lag between the availability of new products and the required AT support 

(2). This creates a cycle in which AT support is always a step behind development of mainstream 

products. Development of HCI models that apply to disabled users will assist in the creation of 

requirements specifications for products that are truly accessible. 

1.2 COMPUTER ACCESS EVALUATIONS 

Initial assessments of clients for assistive technology to support computer access are often too 

brief in duration with little to no follow up to assess performance after the client has become 

accustomed to using the technology (7). Additionally, the assessment often relies heavily on the 

experience of the clinician with qualitative input from the client. This input from the client, while 

a critical component of the assessment process, will typically reflect ease of first use for the 

technology, which may differ significantly from effective long-term use (8).     

Effective performance must be defined as it relates to a given client’s goals and abilities. 

Often optimization of the time required to complete a task is sufficient to maximize performance 
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however in some cases performance is strongly influenced by the onset of fatigue. In this 

situation minimizing motor requirements (keystrokes, mouse clicks, switch activations, etc.) 

assumes greater importance. The goal of performance measurement and prediction is to identify 

solutions that will support sustained, optimal usability for an individual client with their system. 

Software developers use HCI modeling techniques to predict user interaction with 

systems in various stages of development in order to optimize performance. These predictions 

may include specification of the methods a user will select and the corresponding execution time 

to complete a specified task. It is postulated that a similar approach can be used to develop 

models for computer access assessment in clinical practice. Techniques are required to support 

prediction of user performance under varying conditions ranging from novice use, in which the 

user is learning the system features, to a level of expertise often characterized by automaticity of 

motor response. Performance predictions should also consider variations in physical condition, 

the effect of multiple conditions, and the effects of user fatigue. Ideally quantitative measures of 

specific functions would be obtained as part of the assessment process and then inserted into 

empirically validated models to provide predictions of future performance under a variety of 

conditions.   
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2.0  BACKGROUND 

2.1 HCI MODELING 

Models are used to provide approximations of system behavior, most often prior to availability 

of the complete system. In this way, they allow designers to experiment with different options 

without requiring a prototype and subsequent testing of each concept. Models can range in detail 

and complexity from engineering models which use mathematical expressions to predict 

performance to descriptive models which provide a framework for designers to describe and 

think about problems (9). The strength of using models lies in the ability they give designers to 

explore the design space while minimizing time and cost.   

2.1.1 MHP (Model Human Processor) 

The model human processor (MHP), introduced by Card, Moran, and Newell (10), is one of the 

most widely recognized human information processing (HIP) models ever developed (11). MHP 

is a simplistic engineering HIP model that supports prediction of processing sequences and 

durations relatively accurately for able-bodied individuals based on established normal ranges of 

values.    

MHP is based on the notion that a human can be modeled as a computer system 

consisting of perceptual, cognitive and motor processors with working and long term memory 
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storage (10). These processors are assumed to function in series and principles of operation are 

provided that describe performance.        

For a given task, cognitive psychology provides the basis for predicting the number and 

sequence of cycles executed by each processor. Additionally, typical ranges for the perceptual, 

cognitive and motor cycle times have been established for the able-bodied population (10, 12). 

Combining this information allows fairly accurate prediction of the sequence of processing 

cycles and the total response time for a given stimulus for able-bodied individuals.   

Unfortunately due to the level of granularity required, use of the MHP can be quite labor 

intensive for all but the simplest of tasks making it impractical for modeling real world 

applications.    

2.1.2 GOMS (Goals, Operators, Methods, and Selection rules) 

In order to successfully model human computer interaction one must understand both the 

application or system being used and the anticipated manner in which the user will interact with 

the system to achieve the desired goals. One of the most widely used families of models within 

HCI is GOMS. The basic premise driving the GOMS models as described by Card, Moran, and 

Newell (10) is a general description of human interaction with the world at large. When humans 

decide to accomplish something, they establish a goal, perform some sequence of actions to 

achieve the goal and evaluate the result (8). GOMS is based on identification of goals to achieve, 

operators (primitive actions performed by the user), methods (sequences of operators) and 

selection rules (determine which methods should be applied when multiple options are 

available). There are a variety of GOMS modeling techniques available to designers; John and 

Kieras (13) provide guidelines for selection of the most appropriate technique to use based on the 
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design situation. The GOMS models are widely accepted in the HCI community and have been 

validated in a plethora of diverse real world applications (11).             

2.2 PREVIOUS RESEARCH 

2.2.1 MHP 

Efforts to use established MHP models to predict performance of disabled individuals have been 

somewhat inconclusive due to limited sample sizes, the information available from the data 

collected, and lack of statistical analysis. These preliminary studies have found an increase in 

perceptual and cognitive cycle times in addition to discrepancies in motor processing 

performance (5, 14). As expected, motor performance varied significantly depending on the 

degree of motion impairment experienced by the participant. For severely motion-impaired 

participants it appeared that additional perceptual and/or cognitive processing cycles were 

inserted throughout motor processing. Conclusive sequences of the processing cycles could not 

be determined based on the data captured.   

Researchers speculated that additional workload was placed on these participants due to 

the effort required to control physical movement. The source of the unanticipated perceptual 

and/or cognitive cycles may have been the need to process feedback concerning the movement 

and to make frequent adjustments (5, 14). A thorough examination of the mental workload 

related to motor processing is called for in order to understand the effect of motor impairment on 

MHP models.   
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2.2.2 GOMS 

Koester and Levine (15-19) have done extensive work creating and validating keystroke level 

GOMS models for performance with word prediction systems. An unanticipated conclusion 

drawn from their analysis was that use of word prediction does not necessarily improve text 

entry rate (15). In some cases keystroke savings does not balance out the increased cognitive and 

perceptual load induced when using word prediction. The mental cost of using word prediction 

was apparent in data collected for both able-bodied and disabled participants but was most 

prominent in data from participants with spinal cord injury (SCI) (17). Key press time increased 

by almost 50% for these participants when word prediction was used. Accuracy of a priori 

predictions for word entry times was good with an error of 20% for able-bodied participants and 

35% for participants with SCI (18). However generalizability of these results is questionable due 

to the conditions under which the models were created and tested. Participants were asked to 

follow specific strategies when using word prediction, data including errors was discarded, 

recruitment of participants with disabilities was limited to those with SCI, and the number of test 

sessions may not have provided enough practice for learning purposes. Building on their 

previous work Koester and Levine (19) created and simulated models examining the effect of 

different system configurations and user strategies with word prediction systems in order to show 

the clinical applications of model simulations. Overall, their work provides an excellent example 

of the benefits which can be incurred through modeling and simulation in both design and 

clinical assessment.      
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2.3 MOTIVATION 

Research concerning modeling performance for individuals with disabilities has been extremely 

limited. Models which are applicable to individuals with disabilities are essential for both 

product development and clinical practice. Universal design will never be achieved until 

individuals with disabilities are included as part of the target user group during product 

specification and development. Given the difficulties recruiting these individuals for user testing, 

modeling is a primary option available to achieve the required accessibility. Beyond universal 

design is the need for developers of AT to understand the abilities and limitations of their target 

user group. The diversity of disabilities and compounding issues of multiple disabilities result in 

a wide expanse of functionality. Collection of functional and performance measurements from 

individuals with disabilities would provide useful information for AT developers. This functional 

data could be managed and dispersed similar to anthropometric data.   

Additionally, models of performance which are applicable to individuals with disabilities 

can serve to expand the options available to clinicians performing computer access assessments. 

Tools such as Compass (20) and EvaluWare are helpful in providing comparisons of 

performance when clients are able to try different products, thus depending on time and product 

availability during an assessment. There is a need for quantitative methods of determining the 

appropriate match between assistive technology and clients which do not rely on the client 

testing a large number of products and configurations. The ability to model interaction between a 

product and a client could be used to determine if there is a potential fit between the two and if 

so, to appropriately configure the system for the client. Clinicians could determine if a given 

product should be requested for trial when the product is not available in the clinic or present at 

the site of the evaluation. Models could assist clinicians in dealing with the problems of limited 
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time with clients, limited products for the client to try, and the seemingly unlimited system 

configurations available with many potential solutions. With this assistance the computer access 

assessment process could provide more effective long term solutions for individuals.     
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3.0  RESEARCH QUESTIONS 

Eleven participants were recruited and asked to transcribe sentences using an on-screen keyboard 

while time-stamped keystroke and eye fixation data was collected. Visual fixations on identified 

areas of interest and keystrokes were categorized individually as events. A sequences of events 

consisted of one or more visual fixations followed by a keystroke. Each sequence of events was 

categorized based on the type of keystroke that terminated the sequence. Keystroke types 

included error correction, word prediction selection, alphabetical character, space and enter. The 

text entry interface supported both letters-only and word prediction enhanced typing conditions. 

Sentences were presented in blocks of five with blocks ordered randomly via a Latin square.    

3.1 RESEARCH QUESTION 1: ACTION SEQUENCES 

Do individuals establish consistent sequences of actions used to interact with the system? 

Predictable behavior is essential in order to achieve accuracy with modeling techniques. Ideally 

an individual would execute the same sequence of actions each time a particular task was 

performed. In a variation which is still conducive to modeling, an individual would establish 

clear guidelines for the selection of sequences of actions used to perform a particular task. The 

selection would be based on one or more quantifiable properties of the task. The GOMS 
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modeling techniques support this notion with selection rules which identify the methods used to 

perform a task.        

All one and two fixation sequences in the collected data were tallied for each keystroke 

type for each participant. From these tallies, transitional frequency and probability matrices were 

created. In order to determine if the identified sequences occurred by chance or if sequences of 

behavior are truly indicated, the observed probability matrix was compared to a modified first 

order model.  A z-score binomial test was performed to produce a matrix from which each z-

score was examined for significance. Significant z-scores indicated that the corresponding 

sequence was a strategy adopted by the participant instead of simply a sequence of actions 

occurring by chance.  

3.2 RESEARCH QUESTION 2: EFFECT OF EXPERIENCE 

Does performance change as individuals gain experience using word prediction? 

As mentioned previously, accurate modeling relies on predictable performance by the individual. 

In the event that performance measures change as individuals gain experience using the system, 

static models created a priori or based on measures acquired prior to the individual interacting 

with the system would not accurately predict performance over the course of time.        

Data collected for able-bodied participants solely was used in the analysis due to the 

limited and varying number of trials completed by participants with disabilities. Summary data 

was computed for each sentence trial within a block and then averaged on a per block basis. 

These averages were compared to determine if performance changed as the participant gained 

experience using the system. The effect of block order on text entry rate, keystroke rate, 
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successful anticipation, and word prediction list search duration was examined. Significance was 

determined by performing a one-way repeated-measures ANOVA with α = 0.05.   

3.3 RESEARCH QUESTION 3: PERFORMANCE DIFFERENCES 

How does performance differ for able-bodied individuals and individuals with disabilities? 

Differences in performance measures for able-bodied individuals and individuals with 

disabilities would indicate there is a need for models calibrated specifically for different user 

groups. While data for the able-bodied participants can be pooled together and used to represent 

the group, for a variety of reasons the data for the individuals with disabilities cannot. There 

were a limited number of participants and the individuals with disabilities differed to a great 

degree in diagnosis, severity and the amount of data collected. Due to these limitations, 

comparisons can only be made on a qualitative basis between the able-bodied group and the 

individual participants with disabilities. Table 2 shows the measures which were examined. 

These variables are defined in detail in the Analysis section on page 46.  
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Table 2. Data examined 

text entry rate 

keystroke rate 

keystroke savings compared to letters only 

keystroke savings compared to optimal letters only 

keystroke savings compared to optimal word prediction 

total error rate 

uncorrected error rate 

corrected error rate 

utilized bandwidth 

wasted bandwidth 

successful anticipation 

successful list search time 

unsuccessful list search time 

positive list search time 

false positive list search time 

fixations on presented text 

fixations on transcribed text 

fixations on the on-screen keyboard 

 

The mean for each of the identified variables of interest was computed on a per block 

basis. A block consists of five trials; each sentence is a trial. Data for all of the blocks completed 

by the able-bodied participants was used to calculate a mean and 95% confidence interval for the 

group for each variable. On an individual basis, the data for each of the participants with a 

disability was used to calculate a mean and 95% confidence interval for each variable. Note that 

data for Participant 4 is missing in some comparisons as this participant only completed a single 

block with the letters only typing condition thus precluding the computation of a confidence 

interval. The data for the able-bodied group and each of the participants with disabilities was 
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plotted together for the purpose of comparison. This approach inherently accounts for the 

difference in the amount of data collected while providing an indication of how performance 

differed between able-bodied and individuals with disabilities.   

3.4 RESEARCH QUESTION 4: FEASIBILITY OF MODELING 

Can models be created based on the collected data? 

The feasibility of creating models of any type is dependent on consistent behavior by the user. 

Sequences of actions and consistent times for performing primitive operations are critical 

components. The first research question examined the existence of action sequences. Primitive 

operations can include operations at various levels of granularity with a finely grained analysis 

breaking a key press down into components including the time for the decision to perform the 

action. The data collected in this study was examined for consistency at a much higher level. 

Consistency in time between keystrokes and word prediction list search durations were examined 

by calculating confidence intervals.    

Confidence interval data for time between keystrokes and word prediction search 

durations were used to show the uncertainty of predictions made by Koester and Levine’s (18) 

KLM model of performance with word prediction. This demonstration of the range of resulting 

predictions was used to illustrate the difference between performance predictions made for able-

bodied and individuals with disabilities.  
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4.0  INSTRUMENTATION 

The test bench consists of two computers running seven software applications. Main components 

include a text entry interface developed in house which records time stamped keystroke events 

and a system which collects time stamped eye fixation data. The text entry interface, which 

supports word prediction, is used as an example of the type of operations that users typically 

perform when using a computer. The environment simulates an array of demands placed on the 

individual and their corresponding responses. The participants were asked to type quickly and 

accurately using an on-screen keyboard. The use of artificial strategies was neither imposed nor 

encouraged. An on-screen keyboard was used in order to keep the participant’s eyes on the 

computer monitor throughout the test thereby simplifying the collection of eye tracking 

information.  The test setup is described in detail in the following sections. Figure 1 is a digital 

photo of the system. 
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Participant’s PC ISCAN PC

Figure 1. Test setup 

4.1 THE PARTICIPANT’S PC 

The participant was asked to use an on-screen keyboard to transcribe sentences within a text 

entry interface which supports both letters only and word prediction enhanced typing. Screen 

resolution was set to 1024x768 pixels to make the applications easy for the user to view while 

maintaining an appropriate distance for the eye tracker to collect data. This resolution is also 

recommended when using the Morae Recorder which will be explained in a later section.  A 

photo and screen shot of the participant’s PC are shown in Figure 2 and Figure 3 respectively.   
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Figure 2. Photo of participant’s PC 
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Figure 3. Screen shot of participant's PC 

4.1.1 Text Entry Interface 

The foundation of the test bed is a text entry interface which supports letters-only and word 

prediction enhanced typing with numerous configurations. The program is written in Java and 

requires the J2SE runtime environment. Figure 3 shows the application with word prediction 

active.    

For the purposes of this study, when word prediction was active the configuration was set 

to always show the prediction list with a maximum list length of five words. The application 

presents sentences in groups of five for the user to transcribe while keystrokes are collected, time 
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stamped, and written to a log file. Sentences used by the interface are representative of the 

English language; they are combinations of phrases from the set identified by MacKenzie and 

Soukoreff (21). Sentences are limited to lower case and contain no punctuation as inclusion of 

these elements acts as a confounder when variations are found in dependent measures (21). 

Analysis of the sentences produces the profile shown in Figure 4. 

 

--------------------------------------- 
phrases: 50 
minimum length: 50 
maximum length: 55 
average phrase length: 52.3 
--------------------------------------- 
words: 517 
unique words: 302 
minimum length: 1 
maximum length: 14 
average word length: 4.15 
words containing non-letters: 0 
--------------------------------------- 
letters: 2615 
correlation with English: 0.9516 

 

Figure 4. Profile of presented text 

Appendix A contains an example output file from the text entry interface.   

4.1.2 On-screen Keyboard 

Selection of the on-screen keyboard was based on the text entry rate achieved by the participant 

during practice trials. Practice trials were performed with the Microsoft Windows XP on-screen 

keyboard. For participants performing the practice transcription below 0.65 char/sec (8 

words/min), the keyboard was changed to WiViK in an attempt to simplify the transcription 

process by providing larger targets on the keyboard. Figure 5 shows a screen shot of the 
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participant’s PC with the WiViK on-screen keyboard. Note that the word prediction feature in 

WiViK is disabled.  

 

Figure 5. Screen shot of participant's PC with WiViK on-screen keyboard   

4.1.3 Morae  

The test session was recorded using Morae, usability test software produced by TechSmith. The 

software consists of two components, a recorder used to control data capture and a manager used 

for project creation, playback, and interaction. The recording contains all desktop activity 

including time stamped events, screen capture of the entire desktop, and a webcam video which 

can all be replayed in sync with each other. The webcam was set up to record data on the eye 
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tracking machine which will be discussed in a later section. Appendix B contains further details 

concerning the Morae configuration.   

Figure 6 is a screen shot of the Morae Manager with a project containing data for one of 

the participant’s trials open. The playback data includes a screen capture of the entire desktop 

with a red arrow indicating the active window. Below the screen capture is a list of the time 

stamped keystroke and windows system events. To the left is the webcam video of the ISCAN 

machine. The current location of the participant’s eye gaze is circled in red and labeled as “point 

of regard”.       

 

Point of Regard 

Figure 6. Screen shot of Morae Manager playback 
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In the example shown, the participant is in the process of transcribing the word “allergic”. 

The current event is a keystroke of the letter ‘l’; the cursor is shown on the ‘l’ key of the on-

screen keyboard. The text entry application is the active window receiving keystrokes in the 

transcribed text area. The word prediction list appears in the upper left corner of the screen. The 

camera view in the lower left of the manager window shows that the participant’s point of regard 

is on the word prediction list. 

4.1.4 Atomic Clock Sync 

In order to allow the time stamped data from the two computers to be combined, each computer 

must have its clock synchronized. Atomic clock sync is a free utility that was run to ensure the 

computer is up to date with the exact current time. Figure 7 is a screen shot of the clock sync 

application. Clicking on the “Ping Now” button initiates a comparison between the PC clock and 

the exact current time.  
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Figure 7. Screen shot of Atomic Clock Sync 

4.2 ISCAN PC 

The second computer contains hardware and software to record eye tracking information. This 

machine is dedicated to ISCAN hardware and software and is only connected to the Internet by a 

wireless USB 2.0 network adapter for anti-virus software updates, participant data transfer, and 

atomic clock sync. Figure 8 is a digital photo of the ISCAN PC.  
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Figure 8. Photo of ISCAN PC 

4.2.1 Hardware 

As shown in Figure 9, a remote camera referred to as the eye imager is positioned directly in 

front of the participant’s PC facing the participant and connected to a card in the ISCAN PC. The 

eye imager consists of an infrared light source and a camera.  

The monitor input from the participant’s PC is run through a DVI (digital video in) to 

VGA (video graphics array) converter which connects to an AVerKey iMicro necessary to 

provide the video input to the RK-630 PCI card in the ISCAN PC. This card provides the ISCAN 

software with a picture of the scene the participant is viewing on which a cursor marking point of 

regard is superimposed in real time. As mentioned previously in the section describing Morae 
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and shown in Figure 8, this scene was recorded by a webcam and stored as part of the Morae 

recording.   

 

Eye Imager 

Figure 9. Photo of participant’s PC 

4.2.2 Software 

4.2.2.1 DQW – ISCAN Raw Eye Movement Data Acquisition Software 

This application was used to control system calibration, data capture, real time data viewing, and 

storage. Figure 10 is a screen shot of the application during data acquisition.  

 26 



 

    Pupil and Corneal Reflection 

Figure 10. DQW screen shot 

 

The center pane which is labeled “VIDEO 1 – EXPANDED VIEW” shows the current 

activity on the desktop of the participant’s PC with a cursor showing the participant’s current 

point of regard which was on the word prediction list when the screen shot was taken. The 

horizontal and vertical coordinates of the current point of regard are shown near the bottom 

along with a timestamp. VIDEO 2 is the view from the eye imager with crosshairs overlaid 

which show the current position of the participant’s pupil and corneal reflection for each eye.  In 

the lower portion of the middle pane are the track active checkbox and the camera controls. The 

pan / tilt control can be adjusted automatically by the DQW software or manually using the 

arrows to the right. The auto adjustment worked relatively well as long as the participant’s 

movement was slow and smooth. This option did not work well for participants with spastic CP. 

In these cases the researcher had to manually adjust the camera pan / tilt frequently. The eye 

tracking controls appear in the upper left; these settings are used for detection of the participant’s 
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pupil and corneal reflection for each eye. The auto adjustment worked well for most participants, 

those with glasses seemed to require more manual adjustment. The data recording controls 

appear in the lower left pane. These controls are used to initiate and terminate data capture. 

Appendix C contains examples of the output files generated by this application.  

4.2.2.2 PRZ – ISCAN Point of Regard Data Analysis Software 

This application was used primarily for data viewing purposes. Details concerning the use of this 

application are provided in Appendix D. Figure 11 is a screen shot of the PRZ display showing 

fixations identified from collected data overlaying the registered bitmap. The orange lines in the 

screen shot are saccades, rapid eye movements used to relocate the eye between fixations.    

 

Figure 11.  PRZ fixation viewing screen shot 
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4.2.2.3 Atomic Clock Sync 

The computer must be connected to the Internet via the wireless network adapter in order to run 

the clock synchronization utility which is described in section 4.1.4.   
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5.0  METHODOLOGY 

5.1 STUDY DESIGN 

This study was exploratory research in the sense that collected data was examined to identify 

potential relationships among a variety of factors. Potential relationships between sequences of 

actions and resulting event types, performance measures and experience, and diagnosis and 

performance were examined. 

5.2 PARTICIPANTS 

Participants were recruited via posting an Institutional Review Board (IRB) approved flyer in 

Forbes Tower and word-of-mouth advertising.     

5.2.1 Inclusion Criteria 

Participants between the ages of 21 and 65 were recruited. Participants were required to possess 

the ability to use some form of hand operated pointing device (mouse, trackball, track pad, 

joystick, etc.), visual acuity to enable use of a computer with screen resolution set to 1024x768 
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pixels, and head control to maintain a stable position (movement of a few inches was acceptable) 

while performing tests.   

5.2.2 Exclusion Criteria 

Participants could not use bifocals or trifocals as their use could potentially require extensive 

head repositioning.   

5.2.3 Participants 

A total of eleven individuals participated in the study; the breakdown was five able-bodied 

individuals and six individuals with disabilities. Able-bodied participants are identified via letters 

while participants with disabilities are identified via numbers. Table 3 shows a summary of the 

primary diagnosis for the participants with disabilities.     

Table 3. Primary diagnosis for participants with disabilities 

Participant Primary Diagnosis 

1 Dwarfism & incomplete SCI (C5/6 and L1/2) 

2 CP  

3 SCI (C5/6) 

4 CP 

5 SCI (C5/6) 

6 CP 
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5.3 PROTOCOL 

Data was collected in a single session lasting approximately two hours. Participants were asked 

to transcribe sentences in blocks of five using an on-screen keyboard while maintaining a fairly 

stable head position (movement of a few inches). Breaks were offered between blocks. Able-

bodied participants were asked to complete a minimum of 12 blocks comprising a total of 60 

sentences. Participants with disabilities were asked to complete a minimum of six blocks 

comprising a total of 30 sentences. While participants were asked to complete a minimum 

number of sentences, in some cases they were not able to do so in the allotted time. Participant 2 

in particular took an extremely long time for transcription, only completing seven sentences. 

Data for this participant was not used in analysis. Participant 4 only completed a single block of 

letters only typing which was not enough to calculate confidence intervals for that typing 

condition. Participants 1 and 5 were able to complete more trials than requested. Table 4 shows 

the number of sentences completed by each participant. 
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Table 4. Number of sentences transcribed by each participant 

Participant Number of Sentences Transcribed

A 60 

B 60 

1 40 

2 7 

C 60 

3 30 

D 60 

4 25 

E 60 

5 80 

6 30 

 

The order of the sentence blocks and the configuration (letters only, word prediction) 

were selected randomly based on a 6x6 Latin square for able-bodied participants and a 3x3 Latin 

square for participants with disabilities (22). Table 5 is the 6x6 Latin square with each column 

showing the order of sentence block transcription for a participant. The word prediction typing 

condition was used for 10 blocks; the letters only typing condition was applied to two blocks.   
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Table 5. Order of sentence block transcription and typing condition 

Participant A B C D E 
 blocks 9 + 10 blocks 1 + 2 

(letters only) 
blocks 7 + 8 blocks 5 + 6 blocks 3 + 4 

 blocks 11 + 12 blocks 3 + 4 blocks 9 + 10 blocks 7 + 8 blocks 5 + 6 
(letters only) 

 blocks 1 + 2 blocks 5 + 6 blocks 11 + 12 blocks 9 + 10 
(letters only) 

blocks 7 + 8 

 blocks 3 + 4 blocks 7 + 8 blocks 1 + 2 
(letters only) 

blocks 11 + 12 blocks 9 + 10 

 blocks 5 + 6 
(letters only) 

blocks 9 + 10 blocks 3 + 4 blocks 1 + 2 blocks 11 + 12 

 blocks 7 + 8 blocks 11 + 12 blocks 5 + 6 blocks 3 + 4 blocks 1 + 2 
 

5.3.1 Procedure 

5.3.1.1 Setup 

The test environment was set up prior to the arrival of the participant. Setup consisted of creating 

folders for data storage, initializing the applications, syncing the clocks on both PCs, and 

calibrating the ISCAN machine. Detailed instructions for setup are provided in Appendix E.     

5.3.1.2 Informed Consent 

When the participant arrived, a discussion occurred in which the details of the study and the 

protocol were discussed and the consent form was explained. The consent form is provided in 

Appendix F.   

5.3.1.3 Questionnaire 

The participant was asked to fill out the preliminary questionnaire in Appendix G and the 

consumer survey in Appendix H. This information was collected for the purpose of acquiring 

information about independent variables such as diagnosis and to identify potential confounding 

factors. 
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5.3.1.4 Positioning 

An adjustable chair was provided for participants without wheelchairs. Adjustments were made 

to the chair seat to floor height and armrest height for the comfort of the participant. An Ergorest 

adjustable support was available to provide an armrest for participants with manual wheelchairs. 

The PC was on a two level height adjustable computer desk to support adjustment for the 

participant’s comfort. Participants sat upright in a comfortable position approximately one and a 

half to two feet from the ISCAN eye imager with their eyes hitting just below the midline of the 

computer monitor.         
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Figure 12. Photo showing positioning 

5.3.1.5 Calibration 

The ISCAN system required calibration for each participant. Calibration allowed the eye tracker 

to calculate the relative position of the pupil and corneal reflections for known locations. A 
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power point calibration slide show was used to mark the areas of fixation required by the ISCAN 

equipment. The participant was asked to fixate on a point on each slide while the researcher 

initiated entry of the calibration point with the DQW controls. The calibration procedure is 

provided in detail in Appendix I.   

5.3.1.6 Practice 

The participant was given the opportunity to practice transcribing sentences using the test bench 

with word prediction active. Eye tracking was active during the practice trials but data was not 

saved. As mentioned in section 4.1.2, in the event that the text entry rate was below the cutoff, 

the on-screen keyboard was changed to WiViK and the practice session was repeated. This 

situation only arose for Participant 2 and as mentioned previously, the data for this participant 

was not used in analysis due to the limited amount collected. The practice procedure is provided 

in Appendix J.   

5.3.1.7 Breaks 

The participant was encouraged to take breaks between sentence groups and stretch. The system 

was recalibrated as needed based on the participant’s movement.   

5.3.1.8 Data Collection 

Data collection began by starting the Morae Recorder so that the configuration for the text entry 

interface would be recorded in case of any questions after completion of the session. The text 

entry interface was then configured by selecting the sentence group to be transcribed and 

enabling or disabling word prediction depending on the specified typing condition. Eye tracking 

was set to active in the DQW application and the pan / tilt control was set to auto. The 
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transcription test was started in the text entry interface and data recording was initiated in DQW. 

The participant transcribed a total of five sentences by typing with the on-screen keyboard while 

the researcher monitored the ISCAN display to confirm the participant’s eyes were tracked 

properly and to make adjustments as needed. Adjustments were necessary as participants tended 

to shift and change position even while attempting to remain still. Data from both the text entry 

interface and DQW was saved upon completion of the last sentence in the block. The process 

was repeated for each block of sentences transcribed by the participant. The data collection 

procedure is provided in detail in Appendix K.   

5.3.1.9 Data Storage 

The data storage procedure is provided in Appendix L. Table 6 provides a brief summary of the 

data files created for each configuration (letters only and word prediction) - sentence group 

combination completed by the participant.    
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Table 6. Data files 

Application Filename Contents 

Text Entry  configuration_sentencegroup.wp Time stamped keystroke 

events, wp list contents, 

summary measures 

Morae morae_project_configuration_sentencegroup\ 

configuration_sentencegroup.rdg 

morae_project_configuration_sentencegroup.mpr

morae_project_configuration_sentencegroup.psc 

morae_project_configuration_sentencegroup.ptc 

morae_project_configuration_sentencegroup.ptcf 

morae_project_configuration_sentencegroup.stv 

Entire Morae project – time 

stamped events, screen 

capture, webcam video 

ISCAN 

DQW 

configuration_sentencegroup_raw.tda 

configuration_sentencegroup_fix.fxn 

Point of regard data – screen 

coordinate samples 

Fixation data – fixation 

sample numbers and screen 

coordinates 

ISCAN 

PRZ 

configuration_sentencegroup_fix_list.txt Fixation data – area, 

coordinates, start time, 

duration 

5.4 DATA MANAGEMENT 

As indicated in the data storage procedure, all electronic data was backed up on the School of 

Health and Rehabilitation Sciences network drive under Simpson Lab\Jen\subject_data.  The 

consent, questionnaire, and survey forms were stored in a locked cabinet in Dr. Simpson’s office. 
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6.0  DATA  

6.1 DEPENDENT VARIABLES 

Table 7 summarizes the dependent variables measured in the study on a per sentence basis. 

These measures were provided as data output from the test bench and were used in subsequent 

data analysis either directly or to calculate other metrics as defined in the data analysis section.  

Table 7. Dependent measures 

Variable Definition 
event sequences strings of codes identifying fixations appearing in order of occurrence (per keystroke) 
text entry rate average number of characters produced in a second (char/sec) 
keystroke rate average number of keystrokes entered in a second (keystrokes/sec) 
input stream (I) sequence of keystrokes performed by the user 
transcribed text (T) final sequence of characters resulting from the keystrokes 
incorrect fixed (IF) errors in input stream but not appearing in transcribed text 
incorrect not fixed 
(INF) 

errors appearing in transcribed text 

fixes (F) keystrokes that perform corrections (backspace) 
correct (C) alphanumeric keystrokes that are not errors 
positive list searches number of times user searched the word prediction list when the target word was in 

the list (per sentence) 
positive list search 
duration 

total duration of word prediction list fixations when target word was in the list (per 
sentence) 

false positive list 
searches 

number of times user searched the word prediction list when the target word was not 
in the list (per sentence) 

false positive list 
search duration 

total duration of word prediction list fixations when target word was not in the list 
(per sentence) 

negative list searches number of times user did not search list when word was not in list (per sentence) 
false negative list 
searches 

number of times user did not search list when word was in list (per sentence) 

presented text views number of fixations on the presented text per sentence 
transcribed text views number of fixations on the transcribed text per sentence 
on-screen keyboard 
views 

number of fixations on the on-screen keyboard per sentence 
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6.2 ERRORS 

6.2.1 Confounders 

Potential confounders include visual acuity, fatigue, English language skills, short term memory 

capacity and experience with computers, word prediction software, and on-screen keyboards. 

Data concerning confounders related to experience was collected as part of the initial 

questionnaire but division of the participants into groups to control for the confounders was not 

practical for a couple of reasons. There were a limited number of participants and in much of the 

analysis, participants with disabilities were considered on an individual basis.  

6.2.2 Measurement 

The calibration of the ISCAN equipment, which appeared to drift as the machine heated up, was 

a significant source of measurement error. Additionally, calibration was much more difficult 

with some participants than others. The boundaries on the identified areas of interest were 

enlarged to accommodate difficulty in achieving accurate calibration for some participants. 

Difficulty in collecting accurate eye tracking data for some participants can be an issue for 

researchers using a variety of eye tracking systems. Schnipke and Todd (25) studied the use of 

eye tracking systems and found that only 37.5% of the participants in their study provided data 

which could be used in subsequent analysis.  
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6.2.3 Human Error 

6.2.3.1 Researcher 

Inclusion criteria for participation in the study did not specify that a participant’s eyes must work 

together when objects on the screen are tracked and areas are fixated upon. Individuals with 

conditions that prevent their eyes from working together such as a lazy eye or crossed eyes 

should have been excluded from the study. This oversight became apparent when Participant 4 

arrived and it was obvious that one of her eyes drifted and did not focus with the other eye. The 

ISCAN machine had great difficulty tracking her gaze and data collected for this participant is 

not considered reliable.   

In the case of one participant, an error during data collection resulted in the loss of eye 

tracking data for the beginning of a trial. Eye tracking was lost for brief periods during data 

collection as many subjects shifted position. While the camera was readjusted either manually or 

with the automatic option immediately, data was still lost during the adjustment period.   

6.2.3.2 Participant 

In a couple of cases, participants inadvertently minimized or closed the text entry interface 

window resulting in the loss of data.  
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6.3 RAW DATA 

6.3.1 Text Input 

The input stream consisted of all of the keys that were pressed by the participant in the order that 

the keystrokes occurred.  

6.3.1.1 Keystrokes (IF, INF, F, C) 

Soukoreff and MacKenzie (23, 24) define the following four types of keystrokes: 

• Incorrect but fixed (IF) keystrokes are erroneous keystrokes in the input stream that are 

latter corrected. 

• Incorrect and not fixed (INF) keystrokes are errors that appear in the transcribed text. 

• Fixes (F) are keystrokes such as backspace that perform corrections. 

• Correct (C) keystrokes are alphanumeric keystrokes that are not errors.  

6.3.1.2 Keystroke Types (FIX, WPSELECTION, LETTER, SPACE, TRANSITION) 

The text entry interface logs keystrokes according to the following types: 

• Error correction (FIX) keystrokes are keystrokes such as backspace which are used to 

correct errors. 

• Word prediction selection (WPSELECTION) keystrokes are numeric characters entered 

to select a word from the word prediction list. 

• Letter (LETTER) keystrokes are alphabetical characters. 

• Space (SPACE) keystrokes are entered to produce spaces between words. 
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• Enter (TRANSITION) keystrokes are entered to indicate transcription of the current 

sentence has been completed. 

6.3.2 Visual Fixations 

Visual fixations are logged according to the area of the screen in which the fixation occurs and 

the duration of the fixation in seconds. The following areas appear in the PRZ log file: 

• Word prediction list fixations occur within the boundaries of the dialog containing the 

word prediction list. 

• Presented text fixations occur in the area where the sentence to be transcribed appears. 

• Transcribed text fixations occur in the area where the text entered by the participant 

appears. 

• On-screen keyboard fixations occur within the boundaries of the on-screen keyboard.  

• No element fixations are those which occur outside the defined areas of interest.  

Situations where an individual appears to be looking at something but is not really focused will 

be identified as fixations. This behavior confounds as data would appear to indicate increased 

cognitive load related to the transcription task when in reality the individual may have been 

fatigued or distracted by other thoughts.    

6.4 POST PROCESSING 

Perl scripts were written to perform post processing functions on the collected data such as 

combining the text entry and eye tracking data, and extracting pertinent performance summaries.  
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Perl was selected due to its strength in parsing and text manipulation. Version 5.6 of ActiveState 

ActivePerl was used. Appendix M contains detailed descriptions of the data files created by each 

of the Perl scripts. Table 8 summarizes the files which were used for subsequent data analysis. 

Table 8. Post processing data files 

Script Filename Contents 
parse_word_data.pl word_data.xls Detailed keystroke and fixation data on a 

per character basis for words entered 
error free only 

create_list_search_summary.pl search_summary.xls Summary of list search types, number of 
occurrences, and duration on a per 
sentence basis  

parse_sentence_summary_data.pl keystrokes.xls Summary of keystroke types and error 
metrics on a per sentence basis 

parse_sentence_summary_data.pl keystroke_savings.xls Summary of keystroke savings metrics on 
a per sentence basis 

parse_sentence_summary_data.pl text_entry_rate.xls Summary of text entry rate on a per 
sentence basis 

parse_sentence_summary_data.pl keystroke_rate.xls Summary of keystroke rate on a per 
sentence basis 

parse_sentence_summary_data.pl time_between_keystrokes.xls Summary of time between keystrokes on 
a per sentence basis 

parse_all_data.pl all_data.xls Event sequences for every keystroke 
(errors included) 

parse_sequence_data.pl sequence_summary.xls Event sequences, number of occurrences, 
and probability of occurrence for each 

keystroke event type  
parse_sequence_data.pl sequence_analysis.xls Transitional frequency matrices for each 

keystroke event type 
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7.0  ANALYSIS 

7.1 MEASURES OF TEXT ENTRY PERFORMANCE 

7.1.1 Speed 

7.1.1.1 Text Entry Rate 

The text entry rate (TER) was measured in each trial from the appearance of the presented text to 

the time the participant hit the <enter> key. TER focuses on the resulting text, ignoring text that 

was erased by the participant. TER also does not distinguish between text entered by the 

participant and text entered by word prediction.   

TER = (length(T) + 1) / (transcription time) => char/sec 

Table 9 contains the average text entry rate for each block of five trials for each of the able-

bodied participants.  
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Table 9. Average text entry rate (char/sec) on a per block basis 

 block1 block2 block3 block4 block5 block6 block7 block8 block9 block10

A 1.385 1.451 1.219 1.362 1.392 1.555 1.417 1.586 1.562 1.507 

B 1.418 1.263 1.218 1.328 1.253 1.241 1.408 1.204 1.164 1.246 

C 1.503 1.513 1.571 1.551 1.515 1.591 1.635 1.554 1.519 1.504 

D 1.240 1.329 1.352 1.290 1.261 1.362 1.224 1.397 1.381 1.432 

E .858 1.026 1.005 1.070 1.162 1.091 1.087 1.055 .991 1.123 

 

A one-way repeated-measures ANOVA was performed with α = 0.05 to determine if 

block order had a significant effect on text entry rate. Results showed p = 0.628, indicating no 

relationship between block order and text entry rate.     

Figure 13 shows the 95% confidence intervals for the average text entry rate (measured in 

chars/sec) for both of the typing conditions.   

 47 



Text Entry Rate (char/sec) 95% Confidence Intervals
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Figure 13. Text entry rate (char/sec) 95% confidence intervals 

7.1.1.2 Keystroke Rate 

Keystroke rate is the total number of keystrokes entered divided by the total amount of time for 

transcription in seconds. Keystroke rate is thus distinguished from TER in that it reflects all 

keystrokes generated by the user.   

Keystroke rate = (total number of keystrokes) / (transcription time) => keystrokes/sec 

Table 10 contains the average keystroke rate for each block of five trials for each of the able-

bodied participants.  
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Table 10. Average keystroke rate (keystrokes/sec) on a per block basis 

 block1 block2 block3 block4 block5 block6 block7 block8 block9 block10

A 1.216 1.291 1.212 1.202 1.125 1.165 1.079 1.162 1.267 1.153 

B 1.131 .994 .960 1.094 1.004 .877 .961 .852 .948 1.056 

C 1.513 1.503 1.571 1.597 1.538 1.613 1.635 1.595 1.602 1.559 

D 1.219 1.291 1.308 1.229 1.498 1.360 1.501 1.424 1.324 1.265 

E .579 .614 .630 .717 .714 .724 .737 .750 .767 .762 

 

A one-way repeated-measures ANOVA was performed at α = 0.05 to determine if block 

order had a significant effect on keystroke rate. Results showed p = 0.981, indicating no 

relationship between block order and keystroke rate.     

Figure 14 shows the 95% confidence intervals for the keystroke rate (measured in 

keystrokes/sec) for both of the typing conditions. 
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Keystroke Rate (keystrokes/sec) 95% Confidence Intervals
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Figure 14. Keystroke rate (keystrokes/sec) 95% confidence intervals 

7.1.1.3 Time Between Keystrokes 

Confidence intervals for the time between keystrokes for blocks completed using letters only 

typing are shown in Table 11. This data was used as model parameters in subsequent analysis 

examining a proven KLM model. As stated previously, Participant 4 did not complete enough 

blocks of letters only typing to calculate a confidence interval for the time between keystrokes.  

Table 11. Confidence intervals for the time between keystrokes (sec) 

 to from average 
able-
bodied 0.740 0.606 0.673
participant1 1.189 1.083 1.136
participant3 2.055 0.517 1.286
participant4    
participant5 1.31 1.211 1.261
participant6 3.050 2.740 2.895
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Figure 15 shows the 95% confidence intervals for time between keystrokes for both typing 

conditions. 

Time Between Keystrokes (sec) 95% Confidence Intervals
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Figure 15. Time between keystrokes (sec) 95% confidence intervals 

7.1.2 Errors 

These metrics are presented as defined by Soukoreff and MacKenzie (23, 24). 

7.1.2.1 Total Error Rate 

Total error rate is the number of error keystrokes (both corrected and uncorrected) divided by the 

number of correct and error keystrokes. The rate expresses erroneous keystrokes as a percentage 

of total text producing keystrokes.    

Total error rate = (INF+IF)/(C+INF+IF)  x 100 => % 
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Figure 16 shows the 95% confidence intervals for the total error rate which is provided as a 

percentage for both typing conditions.  

Total Error Rate (%) 95% Confidence Intervals
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Figure 16. Total error rate (%) 95% confidence intervals 

7.1.2.2 Uncorrected Error Rate 

Uncorrected error rate is the number of uncorrected error keystrokes divided by the number of 

correct and error keystrokes. This rate is also expressed as a percentage of total text producing 

keystrokes. 

 Uncorrected Error Rate = INF/(C+INF+IF)  x 100 => % 

Figure 17 shows the 95% confidence intervals for the uncorrected error rate which is provided as 

a percentage. 
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Uncorrected Error Rate (%) 95% Confidence Intervals

0

2

4

6

8

10

12

14

16

LO WP LO WP LO WP LO WP LO WP LO WP

AB P1 P3 P4 P5 P6

mean

 

Figure 17. Uncorrected error rate (%) 95% confidence intervals 

7.1.2.3 Corrected Error Rate 

In a similar manner, corrected error rate is the number of corrected error keystrokes divided by 

the number of correct and error producing keystrokes. This rate is also expressed as a percentage 

of total text producing keystrokes. 

Corrected Error Rate = IF/(C+INF+IF)  x 100 => % 

Figure 18 shows the 95% confidence intervals for the corrected error rate which is provided as a 

percentage. 

 53 



Corrected Error Rate (%) 95% Confidence Intervals
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Figure 18. Corrected error rate (%) 95% confidence intervals 

7.1.3 Bandwidth 

7.1.3.1 Utilized Bandwidth 

Utilized bandwidth is the proportion of bandwidth representing useful information transfer. As 

such, it is the number of correct keystrokes divided by the total number of keystrokes. Note that 

the total number of keystrokes includes “fixes” whereas in the previous metrics the denominator 

contained the total number of text producing keystrokes.   

Utilized Bandwidth = C/(C+INF+IF+F) 

Figure 19 shows the confidence intervals for utilized bandwidth or useful information transfer.  
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Utilized Bandwidth 95% Confidence Intervals
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Figure 19. Utilized bandwidth 95% confidence intervals 

7.1.3.2 Wasted Bandwidth 

It follows that wasted bandwidth is the proportion of bandwidth used creating and fixing errors.  

Wasted Bandwidth = (INF+IF+F)/(C+INF+IF+F) 

Figure 20 shows the confidence intervals for wasted bandwidth.  
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Wasted Bandwidth 95% Confidence Intervals
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Figure 20. Wasted bandwidth 95% confidence intervals 

7.2 MEASURES OF WORD PREDICTION USAGE 

7.2.1 Keystroke Savings 

The lengths of the presented text, input stream, and transcribed text were used to calculate 

keystroke savings.  

  length(T) = number of characters in the transcribed text 

  length(I) = number of keystrokes in the input stream 

  length(P) = number of characters in the presented text 
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7.2.1.1 Compared to Letters Only Typing 

Keystroke savings compared to letters only typing reflects the difference between the number of 

keys pressed and the number of characters actually produced. If each keystroke in the input 

stream resulted in a character in the transcribed text, the keystroke savings is zero because the 

lengths of the input stream and the transcribed text are equal. If word prediction is used then the 

length of the input stream is less than the length of the transcribed text and keystroke savings is a 

positive number. If the user commits errors and engages in correction, the length of the input 

stream may be greater than the length of the transcribed text thus resulting in negative keystroke 

savings.    

Keystroke savings compared to letters only = 1 – (length I) / (length T) 

Figure 21 shows the 95% confidence intervals for the keystroke savings compared to letters only 

typing for each of the typing conditions.  
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Figure 21. Keystroke savings compared to letters only typing 95% confidence intervals 
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7.2.1.2 Compared to Optimal Letters Only Typing 

Keystroke savings compared to optimal letters only typing reflects the difference between the 

number of keys pressed and the number of characters in the presented text. Optimal letters only 

typing is such that the user transcribes the presented text exactly, thus requiring a single 

keystroke to enter each character in the presented text. In the event that this condition occurs, the 

keystroke savings compared to optimal letters only is zero. If word prediction is used then the 

length of the input stream is less than the length of the presented text and keystroke savings is a 

positive number. If the user commits errors and engages in correction, the length of the input 

stream will be greater than the length of presented text thus resulting in negative keystroke 

savings.    

Keystroke savings compared to optimal letters only = 1 – (length I) / (length P) 

Figure 22 shows the 95% confidence intervals for the keystroke savings compared to optimal 

letters only typing for each of the typing conditions. 
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Figure 22. Keystroke savings compared to optimal letters only typing 95% confidence intervals 
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7.2.1.3 Compared to Optimal Use of Word Prediction 

Keystroke savings compared to optimal use of word prediction reflects the difference between 

the number of keys pressed and the minimum number of keys needed if word prediction had 

been used to the fullest extent. The minimum number of keystrokes required (MKR) was 

obtained through using a strategy of always searching the word prediction list and selecting the 

target word immediately when it appeared in the list. If word prediction is used in this manner, 

then the keystroke savings would be zero. If word prediction is not used or is used in a less 

efficient manner, then the input stream is longer than the minimum and keystroke savings is 

negative.  

keystroke savings compared to optimal wp = 1 - (length I) /(MKR) 

Figure 23 shows the 95% confidence intervals for the keystroke savings compared optimal use of 

word prediction for each of the typing conditions. 
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Figure 23. Keystroke savings compared to optimal wp use 95% confidence intervals 
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7.2.2 List Search 

Data for word prediction list searches was classified based on detection of a fixation on the word 

prediction list in combination with the presence of the target word in the list. The number of 

occurrences and durations (where applicable) of the following types of searches were used in 

subsequent analysis:  

Positive searches - the participant searched the list and the target word was in the list.   

False positive searches - the participant searched the list and the target word was not in 

the list.   

Negative searches – the participant did not search the list and the target word was not in 

the list 

False negative searches – the participant did not search the list and the target word was in 

the list 

 Data relative to the list search types included the number of occurrences and total 

duration on a per sentence basis. This information was used to calculate the average time for a 

single list search for each positive search type on a per sentence basis.  

7.2.2.1 Positive Searches 

Figure 24 shows the 95% confidence intervals for the duration of a positive list search which is 

measured in seconds.  
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Positive List Search Duration (sec) 95% Confidence Intervals

0

0.1

0.2

0.3

0.4

0.5

0.6

0.7

able-bodied participant1 participant3 participant4 participant5 participant6

 

Figure 24. Positive list search time 95% confidence intervals 

7.2.2.2 False Positive Searches 

Figure 25 shows the 95% confidence intervals for the duration of a false positive list search 

which is measured in seconds. 

 61 



False Positive List Search Duration (sec) 95% Confidence 
Intervals

0

0.2

0.4

0.6

0.8

1

1.2

1.4

able-bodied participant1 participant3 participant4 participant5 participant6

 

Figure 25. False positive list search time 95% confidence intervals 

7.2.2.3 Successful Anticipation 

Successful anticipation occurred when the participant correctly predicted whether the target word 

was in the list or not. It was calculated as the sum of positive and negative searches divided by 

the total number of searches.  

 Successful anticipation = (positive searches + negative searches) / (positive searches + 

negative searches + false positive searches + false negative searches) 

Table 12 contains the average successful anticipation for each block of five trials for each of the 

able-bodied participants.  
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Table 12. Average successful anticipation on a per block basis 

 block1 block2 block3 block4 block5 block6 block7 block8 block9 block10

A .552 .665 .584 .505 .642 .716 .691 .664 .643 .670 

B .600 .644 .591 .744 .655 .600 .608 .473 .612 .656 

C .496 .592 .407 .469 .527 .663 .460 .544 .493 .671 

D .572 .590 .568 .497 .522 .666 .524 .590 .482 .612 

E .503 .599 .565 .637 .655 .628 .636 .697 .663 .636 

 

A one-way repeated-measures ANOVA was performed at α = 0.05 to determine if block 

order had a significant effect on successful anticipation. Results showed p = 0.079, indicating no 

relationship between block order and successful anticipation.     

 

Figure 26 shows the 95% confidence intervals for successful anticipation. 
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Figure 26. Successful anticipation 95% confidence intervals 

7.2.2.4 Successful Searches 

Successful searches occurred when the participant selected the target word from the list during a 

search when the target word was displayed in the list. Figure 27 shows the 95% confidence 

intervals for the duration of a successful list search which is measured in seconds.  
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Successful Search Duration (sec) 95% Confidence Intervals
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Figure 27. Successful list search time 95% confidence intervals 

7.2.2.5 Unsuccessful Searches 

Unsuccessful searches occurred when the participant did not select the target word from the list 

during a search when the target word was displayed in the list. Figure 28 shows the 95% 

confidence intervals for the duration of an unsuccessful list search which is measured in seconds. 
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Figure 28. Unsuccessful list search time 95% confidence intervals 

7.2.2.6 List Search Duration 

Table 13 contains the average list search duration in seconds for each block of five trials for each 

of the able-bodied participants.  

Table 13. Average list search duration (sec) on a per block basis 

 block1 block2 block3 block4 block5 block6 block7 block8 block9 block10

A .207 .148 .229 .206 .178 .164 .167 .227 .213 .157 

B .361 .135 .301 .107 .347 .244 .117 .249 .236 .239 

C 0 .012 0 0 0 0 0 0 0 0 

D .277 .303 .258 .344 .002 .122 .146 0 .106 .137 

E .350 .410 .244 .213 .350 .352 .257 .276 .227 .318 
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A one-way repeated-measures ANOVA was performed at α = 0.05 to determine if block 

order had a significant effect on list search duration. Results showed p = 0.654, indicating no 

relationship between block order and list search duration.     

The average word prediction list search durations across search types were used to 

calculate 95% confidence intervals which are shown in Table 14 and Figure 29.   

Table 14. Confidence intervals for list search duration (sec) 

 to from average 
able-
bodied 0.214 0.144 0.179
participant1 0.342 0.161 0.252
participant3 0.126 0.066 0.0962
participant4 0.942 0.285 0.613
participant5 0.369 0.247 0.308
participant6 0.198 0 0.058

    

List Search (sec) 95% Confidence Intervals

0

0.1

0.2

0.3

0.4

0.5

0.6

0.7

0.8

0.9

1

able-bodied participant1 participant3 participant4 participant5 participant6

 

Figure 29. 95% confidence intervals for list search duration (sec) 
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7.3 VISUAL FIXATIONS 

The number of fixations on the presented text, transcribed text, and on-screen keyboard were 

each tallied on a per sentence basis. The tallies were used to calculate the average number of 

fixations on a per block basis. An average was also calculated for the letters only and word 

prediction enhanced typing conditions.  

7.3.1 Fixations on Presented Text 

Figure 30 shows 95% confidence intervals for the number of fixations on the presented text for 

the letters only and word prediction typing conditions.  
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Figure 30. Fixations on presented text 95% confidence intervals 
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7.3.2 Fixations on Transcribed Text 

Figure 31 shows 95% confidence intervals for the number of fixations on the transcribed text for 

the letters only and word prediction typing conditions. 
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Figure 31. Fixations on transcribed text 95% confidence intervals 

7.3.3 Fixations on On-Screen Keyboard 

Figure 32 shows 95% confidence intervals for the number of fixations on the on-screen keyboard 

for the letters only and word prediction typing conditions. 
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Figure 32. On-screen keyboard fixations 95% confidence intervals 

7.4 VISUAL FIXATION SEQUENCES 

7.4.1 Transitional Frequency Matrices 

Data relative to sequences of fixations was used to calculate transitional frequency matrices for 

each keystroke type (FIX, WPSELECTION, LETTER, SPACE, TRANSITION). These matrices 

were computed using data for all occurrences of one-fixation and two-fixation sequences for 

each participant. Each element of the matrix contains the number of times the identified two-

fixation sequence occurred. The row identifies the first fixation and the column identifies the 

second. Table 15 shows a sample transitional frequency matrix including data combined across 
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all keystroke types. The label “outside” refers to fixations outside the defined areas of interest 

(i.e. a fixation somewhere other than the presented text, word prediction list, transcribed text, or 

on-screen keyboard). The column labeled “none” is for sequences consisting of a single fixation.  

Note that the diagonal is filled with zeros indicating the absence of the transition to self condition 

which is a common assumption in the coding and analysis of behavior sequences (26). 

Table 15. Transitional frequency matrix (observed) 

 presented transcribed 
wp 
list keyboard outside none f(first) 

presented 0 12 35 127 30 212 416 
transcribed 70 0 15 181 102 311 679 
wp list 8 37 0 160 18 394 617 
keyboard 74 143 104 0 171 1263 1755 
outside 70 122 57 126 0 143 518 
f(second) 222 314 211 594 321 2323 3985 

 

Probability matrices corresponding to the transitional frequency matrices were computed by 

dividing each element by the total number of one and two fixation sequences which is located in 

element(f(second),f(first)). The probability matrix corresponding to Table 15 is shown in Table 

16. 

Table 16. Corresponding probability matrix 

 presented transcribed wp list keyboard outside none 
presented 0 0.003 0.009 0.032 0.008 0.053 
transcribed 0.018 0 0.004 0.045 0.026 0.078 
wp list 0.002 0.009 0 0.040 0.005 0.099 
keyboard 0.019 0.036 0.026 0 0.044 0.317 
outside 0.018 0.031 0.014 0.032 0 0.036 
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7.4.2 Number of Samples 

An appropriate number of samples must be collected in order to assign significance to computed 

z-scores. The following equation, adopted by Bakeman and Gottman (26), provides an estimate 

of the number of data points required for significance.   

N = 9 / [P(1-P)]  where N is the minimum number of sequences required and P is the  

expected probability of the least frequent sequence. The zero order model which assumes that all 

codes occur with equal probability is used to provide the expected probability of the least 

frequent sequence. Given no transition to self condition, the probability for any element is 1/25 = 

.04. This results in the following. 

N = 9/[.04(1-.04)] = 234 

Considering that 234 data points must be collected in order for the z-score to be 

significant, the z-scores cannot be compared across keystroke types. Table 17 shows the number 

of samples collected for each keystroke type for each participant. Types with enough data to be 

tested for significance appear in bold.  

Table 17. N collected for each keystroke type for each participant 

participant all fix wp selection letter space transition 
a 3985 193 637 2667 427 61 
b 3799 103 728 2373 492 103 
1 3632 111 582 2430 431 78 
2 750 15 163 512 47 13 
c 5882 101 4 4445 1170 162 
3 4323 213 230 3161 655 64 
d 6088 249 137 4334 1139 229 
4 2982 129 391 1808 592 62 
e 7542 117 2344 4421 497 163 
5 7988 167 1443 5151 1008 219 
6 5240 438 239 3486 986 91 
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7.4.3 Analysis 

Data provided in the event sequence probability matrices was evaluated to determine 

significance. The question is whether the observed transitional frequencies and corresponding 

probabilities occurred by chance or if sequences of behavior are truly indicated by the collected 

data.  

This analysis was based on discussion and instructions provided by Bakeman and 

Gottman (26). To determine significance observed data is compared to expected data typically 

provided by zero or first order models. A zero-order model assumes that all elements in the 

matrix occur with equal probability. A first-order model uses the number of occurrences of each 

fixation but assumes random ordering, i.e. the probability of a given sequence occurring is 

simply the product of the probabilities for the composite individual fixations. Table 18 and Table 

19 contain the frequencies and corresponding probabilities for the transitional frequency matrix 

in Table 15.  

Table 18. Frequency 

 first second
presented 416 222
transcribed 679 314

wp list 617 211
keyboard 1755 594
outside 518 321
none 0 2323

   
total 3985 3985

 

 

 

 

 73 



Table 19. Probability 

 first second
presented 0.104 0.056
transcribed 0.170 0.079

wp list 0.155 0.053
keyboard 0.440 0.149
outside 0.130 0.081
none 0 0.583

   
total 1 1

 

The first order model corresponding to the data in Table 19 is shown in Table 20. 

Table 20. First order model 

 
probability 
(second) 0.056 0.079 0.053 0.149 0.081 0.583 

probability 
(first)  presented transcribed wp list keyboard outside none 
0.104 presented 0.006 0.008 0.006 0.016 0.008 0.061 
0.170 transcribed 0.009 0.013 0.009 0.025 0.014 0.099 
0.155 wp list 0.009 0.012 0.008 0.023 0.012 0.090 
0.440 keyboard 0.025 0.035 0.023 0.066 0.035 0.257 
0.130 outside 0.007 0.010 0.007 0.019 0.010 0.076 
0 none 0 0 0 0 0 0 

 

Given that transition to self does not occur, the first order model can be modified to 

include some information concerning the ordering of transitions. The diagonal is filled with zeros 

as in the observed data and the probability of the second fixation occurring is no longer simply 

the frequency divided by the total number of sequences. Instead the frequency is divided by the 

total number of sequences minus the frequency of the first fixation.  

p(second) = f(second)/(N-f(first)) 

The adjusted model is shown in Table 21. 
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Table 21. Adjusted first order model probabilities 

 presented transcribed wp list keyboard outside none 
presented 0 0.009 0.006 0.016 0.009 0.064 
transcribed 0.010 0 0.010 0.028 0.015 0.108 
wp list 0.009 0.013 0 0.024 0.013 0.095 
keyboard 0.029 0.041 0.027 0 0.042 0.302 
outside 0.008 0.011 0.007 0.021 0 0.082 

   

The corresponding frequency matrix is shown in Table 22. 

Table 22. Adjusted first order model frequencies 

 presented transcribed wp list keyboard outside none 
presented 0 34.713 23.326 65.667 35.487 256.808 
transcribed 41.062 0 39.027 109.868 59.373 429.670 
wp list 36.294 51.335 0 97.111 52.479 379.780 
keyboard 114.895 162.510 109.202 0 166.132 1202.260 
outside 31.385 44.392 29.830 83.977 0 328.415 
 

The frequencies predicted by the adjusted first order model were then compared with the actual 

observed frequencies (Table 15) with a z-score binomial test. The resulting z-score matrix 

appears in Table 23. 

Table 23. Z-score matrix 

 presented transcribed wp list keyboard outside none 
presented 0 -3.872 2.424 7.632 -0.925 -2.891 
transcribed 4.539 0 -3.865 6.882 5.574 -6.061 
wp list -4.718 -2.014 0 6.461 -4.791 0.767 
keyboard -3.871 -1.563 -0.505 0 0.386 2.096 
outside 6.920 11.714 4.993 4.635 0 -10.681 
 

The z-scores in the matrix were examined for significance. Assuming α = .05, a 

Bonferroni correction was applied to adjust alpha based on the number of tests performed. 

Applying the equation, α = α/number of tests, where the number of tests = 6x25 (6 z-score 

matrices with 25 z-scores to test in each), leads to α = .05/150. A two-tailed test requires division 

by 2, thus α = .000167. For a normal curve the area under the body and the tail sum to one; alpha 
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is the area under the tail or the area above z. Using Table A.1 in Portney and Watkins (22), 

which provides areas under the normal curve, an alpha of .000167 corresponds to a z value of 

3.60. This means that z-scores greater than 3.60 (or less than -3.60) are considered significant in 

the sense that they are unlikely to occur. Table 24 shows the z-score matrix from Table 23 with 

significant scores in bold. Appendix N contains the z-score matrices for all of the participants 

with significant scores in bold.   

Table 24. Z-score matrix with significant scores in bold 

  presented transcribed wp list keyboard outside none 
presented 0 -3.872 2.424 7.632 -0.925 -2.891 
transcribed 4.539 0 -3.865 6.882 5.574 -6.061 
wp list -4.718 -2.014 0 6.461 -4.791 0.767 
keyboard -3.871 -1.563 -0.505 0 0.386 2.096 
outside 6.920 11.714 4.993 4.635 0 -10.681 
 

7.4.4 Consistency 

7.4.4.1 Within Subject/Within Keystroke Type 

Data from each participant was partitioned into four groups based on the order in which sentence 

blocks were transcribed. The most probable sequences of fixations for each keystroke type were 

identified for each quarter of the testing and bar charts were created for visual comparison. The 

bar charts appear in Appendix O. An example is shown in Figure 33.    
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Participant A: LETTER
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Figure 33. Bar chart examining within subject within keystroke type consistency 

7.4.4.2 Within Subject/Across Keystroke Types 

Data for each participant was examined over the entire test session to identify the most probable 

sequences of fixations for each keystroke type. The bar charts in Appendix P were created for 

visual comparison. An example is shown in Figure 34.   
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Participant A
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Figure 34. Bar chart examining within subject across keystroke types consistency 

7.4.4.3 Across Subjects/Within Keystroke Type 

Returning to the observed probability matrices for each event type on a per subject basis, the 

most highly probable sequences of fixations were identified. Bar charts were created for each 

keystroke type to compare the most probable sequences across subjects.      
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Fix Keystrokes
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Figure 35. Most probable sequences for FIX keystrokes 
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Figure 36. Most probable sequences for WPSELECTION keystrokes 
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Letter Keystrokes
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Figure 37. Most probable sequences for LETTER keystrokes 
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Figure 38. Most probable sequences for SPACE keystrokes 
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Transition Keystrokes
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Figure 39. Most probable sequences for TRANSITION keystrokes 

 

7.4.4.4 Across Subjects/Across Keystroke Types 

Data for all of the able-bodied participants was combined and the most probable sequences were 

identified for each keystroke type. Figure 40 shows the identified sequences for each keystroke 

type.        
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Able-bodied Participants
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Figure 40. Most probable sequences across able-bodied participants 

 

Confidence intervals for the probabilities of the two most frequently used sequences were 

computed across subjects to check for consistency across keystroke event type.  

Table 25. Probability confidence intervals for sequence keyboard to none 

k->n to from average  

all 0.281 0.130 0.205 

fix 0.226 0.090 0.158 

wpselection 0.204 0.072 0.138 

letter 0.309 0.146 0.227 

space 0.328 0.129 0.228 

transition 0.219 0.059 0.139 
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CIs for seq k->n
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Figure 41. Probability confidence intervals for sequence keyboard to none 

 

Table 26. Probability confidence intervals for sequence keyboard to outside 

k->o to from average 

all 0.115 0.052 0.084 

fix 0.112 0.051 0.082 

wpselection 0.134 0.038 0.086 

letter 0.113 0.049 0.081 

space 0.142 0.065 0.104 

transition 0.166 0.062 0.114 
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CIs for seq k->o
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Figure 42. Probability confidence intervals for sequence keyboard to outside 
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8.0  DISCUSSION 

8.1 RESEARCH QUESTION 1: EVENT SEQUENCES 

8.1.1 Significance 

As shown in Table 17, the number of data points collected varied among participants and key 

stroke type. This was due in part to the number of trials completed by the participants, but a 

larger influence was the style of interaction adopted by the user. The number of data points is 

actually the number of one and two fixation sequences the participant performed. The z-score 

matrices in Appendix N contain data with all key stroke event types combined for each 

participant as all of the participants had the required number of data points to support assignment 

of significance to z-scores under this condition. Examination of the matrices shows that all of the 

participants had significant z-scores indicating the presence of strategies or sequences of 

behaviors. Participant 2 had less data than the other participants, having only completed a single 

block of trials. The other participants had anywhere from 7 to 16 significant z-scores in their 

matrices.    
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8.1.2 Consistency 

As consistency is being examined with the ultimate goal of determining the feasibility of creating 

models based on the collected data, it is useful to frame the discussion around levels of 

consistency. Table 27 shows a matrix of four elements with each element representing a 

combination of consistency within or across subjects and within or across keystroke type.  

Table 27. Levels of consistency 

 within keystroke type across keystroke type 
within 
subjects 

Did individual subjects perform 
consistently when entering a single type 
of keystroke? 

Did individual subjects perform 
consistently when entering all types of 
keystrokes? 

across 
subjects 

Did all subjects perform similarly when 
entering a single type of keystroke? 

Did all subjects perform similarly when 
entering all type of keystrokes? 

 

8.1.2.1 Within Subject/Within Keystroke Type 

Participants showed variation in the sequences most frequently used with the degree of variation 

depending on the individual. For example, Participant 5 showed variation in sequences selected 

over each quarter.  
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Participant 5: WPSELECTION
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Figure 43. Participant 5 probabilities for most frequently used sequences for each quarter of the test session 

 

At the other extreme, Participant D showed almost complete consistency in selection of 

sequences with minor differences between the probability of the first and second most frequently 

used sequences.  
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Participant D: LETTER
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Figure 44. Participant D probabilities for most frequently used sequences for each quarter of the test session 

 

Participant A showed consistency and strong preferences for a particular sequence which is 

highly conducive to modeling. 
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Participant A: LETTER
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Figure 45. Participant A probabilities for most frequently used sequences for each quarter of the test session 

8.1.2.2 Within Subject/Across Keystroke Types 

Participants varied regarding consistency in their choice of sequences for each keystroke type. 

As shown in Figure 46, Participant A consistently showed a clear preference for the keyboard to 

none fixation sequence. 
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Figure 46. Participant A – most probable sequences for each keystroke type 

In contrast, Participant D showed little consistency in sequence selection in addition to 

small differences in the probabilities of the first and second most likely sequences.  
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Participant D

0

0.05

0.1

0.15

0.2

0.25

0.3

TN ON KN WN KN ON ON KO OT KO

FIX WPSELECTION LETTER SPACE TRANSITION

 

Figure 47. Participant D – most probable sequences for each keystroke type 

As shown in Figure 48, Participant 5 performed between the two extremes.  
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Figure 48. Participant 5 – most probable sequences for each keystroke type 
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8.1.2.3 Across Subjects/Within Keystroke Type 

Variation was apparent in the most frequently used strategies for each keystroke type. Of 

particular interest is the chart showing event sequence probabilities for word prediction selection 

keystrokes. It was expected that highly probable sequences for this keystroke type would include 

fixations on the word prediction list but that was not the case. Further examination of the data 

relative to word prediction selection and fixations on the word prediction list shows that on 

average over 50% of the time when word prediction was used, a fixation on the word prediction 

list was not detected.   

Table 28. Word prediction use without list fixation detected 

participant wp used no search % wp used without list search 
A 276 150 54.3 
B 273 124 45.4 
1 140 77 55 
2 47 31 66 
C 2 2 100 
3 39 35 89.7 
D 47 10 21.3 
4 65 23 35.4 
E 379 45 11.9 
5 370 169 45.7 
6 28 14 50 

     

One possible explanation is that participants may have searched the list when entering the 

previous character and located the word but for some reason waited to make the selection until 

the next character. Table 29 expands on the data in Table 28, providing the number of times the 

participant searched the list during entry of the character prior to the word prediction list 

selection. Also included is the number of times the target word appeared in the list when the 

participant performed the search. This data does not support the proposed explanation.   
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Table 29. List fixation during entry of character prior to wp selection 

participant list search prior word in list during search % missed wp list fixations explained
A 56 25 16.7 
B 90 33 26.6 
1 66 25 32.5 
2 5 0 0 
C 1 1 50 
3 12 4 11.4 
D 0 0 0 
4 11 6 26.1 
E 39 17 37.8 
5 51 23 13.6 
6 4 3 21.4 

 

Other possible explanations for the data shown in Table 28 include errors related to data 

collection and list search times shorter than 40 milliseconds. Examination of the Morae 

recordings for selected trials performed by Participant 3 showed periods of time when the point 

of regard was lost. This was likely due to head movement and the time for the corresponding 

auto pan/tilt adjustment. In order to determine if there were shorter fixations on the word 

prediction list, one of the data files for Participant 3 was reloaded into the DQW application and 

a new fixation file was generated based on minimum fixation duration of 20 milliseconds. Figure 

49 and Figure 50 show the old and new fixation files.   
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Figure 49. Fixations with minimum duration set to 40msec 
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Figure 50. Fixations with minimum duration set to 20msec 

 

The large increase in the number of fixations identified in and around the word prediction 

list supports the notion that the participant was performing a list search or possibly a pattern 

matching exercise rapidly. Additionally the fixations identified around the outside of the word 

prediction list indicate that possibly there were calibration issues adding to the number of missed 

fixations.  

Identification of fixations with the ISCAN eye tracking system is based on a minimum 

time period in which the eye must remain fixed and specification of an allowed deviation. This 

deviation is the number of pixels the point of regard can move in the vertical and horizontal 

directions and still be considered “fixed”. Presumably this deviation is included to handle small 
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movements of the eye such as the micro saccades which occur constantly. The maximum 

horizontal and vertical deviations were set to 5 and 3 pixels respectively. All of the settings 

related to the definition of fixations used in the experimental protocol were the defaults 

recommended by the engineers at ISCAN. The data from Participant 3 was reexamined with the 

horizontal and vertical deviations set to 20 pixels each. While fewer fixations were identified, the 

fixations were of longer duration. The likely explanation for this is the merging of fixations that 

were independent with the previous settings.  

Eye tracking systems commonly identify fixations through either dwell time or velocity 

based approaches (28). The exact definition of what constitutes a fixation varies depending upon 

the eye tracking system used. Fixation durations are rarely under 100 milliseconds and are 

typically between 200 and 400 milliseconds (29). Eye movement is classified in terms of 

fixations, pursuits, and saccades. The test bench is not designed to illicit pursuit or tracking of a 

moving target; as such all data should be classified as saccades or fixations. Saccades are eye 

movements used to reposition the fovea. Little to no visual processing occurs during a saccade; 

the eye is essentially blind (28, 29). Given that fact, the point of regard data in the region of the 

word prediction list must indicate fixations on the list. There is simply no other reason for the 

fovea to be positioned in that manner and visual processing is dependent on fixations. This 

reasoning indicates that fixations occurred on the word prediction list and were not properly 

identified by the eye tracking software. The increase in fixations identified in the list region 

when the minimum fixation duration was reduced supports the notion that noise such as tiny 

flickers and micro saccades was not filtered and thus caused the fixation detection algorithm to 

miss or discard a number of fixations.            
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While it is difficult to draw conclusions without a clear definition of what should be 

considered a fixation on the word prediction list, based on the data it appears that in many cases 

participants were searching the list and fixations were not detected. Interestingly, the phenomena 

of word prediction selection without detection of a list fixation only occurred 11.9% of the time 

for participant E. This is considerably less than all of the other participants and fits with what 

would be expected. Qualitative observation during data collection indicated that participant E 

was one of the most careful and deliberate participants which could explain why the duration of 

her fixations on the word prediction list tended to be longer than the other participants.        

8.1.2.4 Across Subjects/Across Keystroke Types 

Overall, the most probable sequence was a fixation on the keyboard followed by a keystroke. 

This is reasonable given that the on-screen keyboard requires visual attention and a keystroke 

ends every event type. As expected based on the sources of error previously identified, data for 

Participant 4 did not follow the trends established by the other participants. Confidence intervals 

in Figure 41 and Figure 42 show no significant difference in the probabilities of the most 

common sequences across keystroke type as the intervals clearly overlap.  

8.1.3 Summary 

Returning to the questions posed in Table 27, trends in the data for individual participants varied 

to a wide degree making within subjects results inconclusive. Data across subjects showed 

slightly more promise given that a couple of sequences appeared to be favored by many of the 

participants and confidence intervals for those sequences were comparable across keystroke type. 

However, there was little consistency in selection of other highly probable sequences when 
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considered across subjects. Variation existed to some degree in the most probable sequences of 

events performed by individuals and to a greater degree in the difference between the 

probabilities of the first and second most commonly performed sequences. This indicates the 

need for a modeling technique that supports a decision making process to identify the sequence 

to be performed in real time. The algorithm required to perform that decision making process 

was not clear based on the data, no clear guideline for sequence selection emerged.       

8.2 RESEARCH QUESTION 2: EFFECT OF EXPERIENCE 

There was an expectation that as participants gained experience using word prediction, they 

would learn to anticipate when a word appeared in the list and develop strategies of use leading 

to improvement in quantitative measures of performance. This was not the case with the data 

collected. Analysis showed that trial order had no significant effect on text entry rate, keystroke 

rate, successful anticipation, or word prediction list search duration. Results were likely 

influenced by the limited number of trials completed and fatigue. Testing occurred over a single 

two hour session which may not have provided the participants with enough practice using the 

system and may also have induced fatigue which could degrade performance.  

8.3 RESEARCH QUESTION 3: PERFORMANCE DIFFERENCES 

Table 30 provides a brief summary for each of the variables examined.   
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Table 30. Performance differences summary 

Measure WP Letters 

text entry rate Y: AB higher Y: AB higher

keystroke rate Y: AB higher Y: AB higher

keystroke savings compared to letters only N N 

keystroke savings compared to optimal letters only N N 

keystroke savings compared to optimal word prediction N N 

total error rate N N 

uncorrected error rate N N 

corrected error rate N N 

utilized bandwidth N N 

wasted bandwidth N N 

successful anticipation N N 

successful list search time N N 

unsuccessful list search time N N 

positive list search time N N 

false positive list search time N N 

fixations on presented text N N 

fixations on transcribed text N N 

fixations on the on-screen keyboard N N 

 

Text entry rate and keystroke rate were clearly higher for the able-bodied group under both 

letters only and word prediction enhanced typing conditions. This was expected as all of the 

participants with disabilities had some form of motor impairment affecting computer access. 

Participant 3 showed an extremely wide confidence interval for both rates during letters only 

typing. This participant had some difficulty positioning the trackball and made frequent 

adjustments throughout the trials.   
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All of the keystroke savings metrics show that the participants with disabilities performed 

on par with the able-bodied group. These metrics focus on the input stream entered by the user 

independent of the time for transcription. Participant 6 had particularly wide confidence intervals 

for these metrics when data for the letters only typing condition was examined; data for the word 

prediction enhanced typing condition more closely tracked that of the other participants.  

Participant 6 had difficulty targeting the keys on the on-screen keyboard and relied on 

word prediction extensively when it was available. She used word prediction to reduce both the 

number of keystrokes required and errors. This participant had the highest corrected error rate 

and the highest average wasted bandwidth with a large confidence interval.  

  Utilized bandwidth or useful information transfer was on par between the able-bodied 

group and the participants with disabilities. Differences in list search times and the number of 

fixations on various locations were unremarkable.   

While differences in the mean values depended on the performance measures being 

examined, the confidence intervals for the able-bodied group tended to be smaller than the 

corresponding intervals for the individual participants with disabilities. The larger variation in 

performance may complicate the development of models to describe performance by these 

participants.  

8.4 RESEARCH QUESTION 4: FEASIBILITY OF MODELING 

Modeling becomes feasible when users adopt consistent strategies or patterns of behavior to 

perform tasks. Strategies are comprised of primitive operations whose execution times must also 
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be consistent. When multiple strategies emerge as being appropriate for completion of a 

particular task, guidelines are required for strategy selection.    

8.4.1 Sequences of Actions 

Consistency across subjects in the sequences most commonly used supports the creation of 

models which are applicable across user populations. The data showed preferences for sequences 

involving fixations on the keyboard but the probabilities for the sequences varied both across 

subjects and across keystroke event types. For letter keystroke events, the difference between the 

probabilities of the first and second most common sequences was pronounced, thereby showing a 

strong preference for a particular pattern which is highly conducive to modeling. However, for 

other keystroke event types such as transitions, there were not such pronounced differences in 

the probabilities of the most common sequences indicating that participants had not adopted such 

clear patterns. It is possible that the limited number of trials did not give participants enough 

practice with less frequent keystroke event types and subsequently clear patterns did not have a 

chance to develop.  

Consistency within subjects is also necessary for model development. Data showed some 

preferences for particular sequences but the magnitude of the probabilities varied throughout the 

test session. This variation did not appear to be a function of practice or learning as no trends 

were evident.   
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8.4.2 Consistent Time for Primitive Operations 

In general, as shown in Figure 15, the participants had relatively tight confidence intervals for 

time between keystrokes with the average for the able-bodied group clearly below that of the 

participants with disabilities. Participant 3 showed a particularly large variation in time between 

keystrokes but the variation in list search time was relatively small. This participant had some 

difficulty using the trackball efficiently as he preferred to keep it on his lap instead of on the 

table surface.   

Confidence intervals for list search time, as shown in Figure 29, indicated that Participant 

4 had large variation most likely due to difficulties mentioned earlier related to eye tracking. 

There was no clear distinction between the able-bodied group and the participants with 

disabilities in regards to the average duration of a word prediction list search.   

8.4.3 Uncertainty in a Proven Model 

In this study word prediction list search time was taken directly from the eye tracking data 

whereas in the study performed by Koester and Levine (18), list search time was estimated by 

subtracting the time for a keystroke from the time for a list search and keystroke. Estimating list 

search time in this manner yields significantly different search times as it includes other activities 

such as fixations on the presented and transcribed text as part of the list search. Table 31 shows 

the actual and estimated list search times in seconds.  
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Table 31. Actual and estimated word prediction list search time in seconds 

participant actual search time derived search time % error 
able-bodied 0.179 0.230 -28.489 
participant 1 0.252 0.495 -96.422 
participant 3 0.096 0.259 -169.759 
participant 4 0.613 1.158 -88.878 
participant 5 0.308 0.480 -55.698 
participant 6 0.058 0.024 58.808 

 

The calculated confidence intervals for the actual list search time and time between 

keystrokes were used in Koester and Levine’s (18) KLM model of performance with word 

prediction. Koester and Levine modeled two strategies their participants were asked to follow. 

Participants following the first strategy were asked to search the word prediction list prior to 

typing a character. The corresponding KLM model for a word which appeared immediately in 

the list is ts + tk. Participants following the second strategy were asked to enter two characters 

prior to searching the word prediction list. The corresponding KLM model for a word which 

appeared immediately in the list is ts + 3tk. Koester and Levine developed equations for each 

word individually. The following calculations of uncertainty assume that the target word always 

appeared in the word prediction list. Clearly any delay in the appearance of the word in the list 

would magnify the uncertainty. Mean values for time between keystrokes and list search duration 

were assumed to be zero in order to simplify calculations and to clearly isolate the component of 

uncertainty. Table 32 shows the cumulative uncertainty for each strategy. 

   

Table 32. Uncertainty for each strategy (sec) 

 strategy 1 strategy 2 
able-bodied 0.102 0.236 
participant1 0.143 0.249 
participant3 0.799 2.336 
participant5 0.111 0.211 
participant6 0.296 0.606 
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Uncertainty for model predictions varied among the able-bodied group and the individual 

participants with disabilities. Participants 1 and 5 most closely tracked performance variation 

showed by the able-bodied group. Participant 3 showed the greatest variation with uncertainty 

using strategy 2 being a factor of 10 greater than that of the able-bodied group. This is a function 

of the time between keystrokes confidence interval discussed above.   

8.4.4 Summary 

While the first research question determined that users do adopt strategies used to interact with 

the system, identification of those strategies and the conditions guiding their selection for 

completion of a particular task are unclear. Execution times for primitive operations were 

reasonably consistent for list search time but varied between the able-bodied group and 

participants with disabilities for time between keystrokes.  

Parameters for primitive operations affected by physical limitations should be different 

for able-bodied individuals and individuals with disabilities. If models are to be created a priori, 

execution times for primitive operations such as keystroke time, mouse movement, etc. must be 

gathered from individuals with disabilities and made available to model developers in a similar 

manner to the parameters currently available that apply to able-bodied individuals. Differences in 

other types of primitive operations would require further research into modifications necessary to 

calibrate existing modeling techniques to make them applicable for different user groups.  

The third research question showed that confidence intervals were often wider for 

participants with disabilities. The calculations of uncertainty in a proven model illustrate the 

effect of those wider intervals by comparing uncertainty of model predictions for able-bodied 
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participants and participants with disabilities. In order to accurately predict performance of 

individuals with disabilities, a modeling technique must be able to accommodate wider 

confidence intervals in some manner.   
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9.0  CONCLUSIONS 

In order to successfully model the collected data, a modeling technique must be capable of 

selecting from among multiple sequences of behavior used to perform a particular type of action. 

While by definition GOMS models can accommodate multiple methods capable of performing a 

particular task, the collected data shows that selection rules may be difficult to develop. The 

technique must also accommodate variation in the execution time for primitive operations which 

could potentially become excessive depending on the ability of the user. Actions should be 

defined at a finer level of granularity than that provided by the KLM to support visibility into 

fixations on areas outside the word prediction list. These fixations are important as they could 

indicate an increase in mental workload experienced by the user. The use of GOMS variants is 

precluded as errors must be handled gracefully instead of assumed nonexistent.   

While this research did not conclusively answer the defined research questions, 

contributions were made in terms of knowledge gained relative to the design of the test bench 

and experimental protocol.  
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10.0  FUTURE WORK 

An overriding conclusion based on the data analysis is the need to better define what constitutes 

a fixation in terms of both duration and deviation. In addition to the size of the word prediction 

list, the visual angle should be considered to determine how much of the list the participant is 

able to view without eye movement. Resolution of this matter will require research on visual 

search and consultation with the engineers from ISCAN. Limitations of the current equipment 

may prohibit the ideal settings but a clear understanding of the issues involved should be attained 

prior to further data collection with the test bench.  

The test bench should be modified to capture time stamped mouse movement in addition 

to keystroke and eye tracking information. This will provide information concerning parallel 

activities such as fixating on the word prediction list while moving the mouse to the on-screen 

keyboard. Parallel activity is an important part of human information processing and could also 

provide insight into the learning process if the study is modified to collect data in multiple 

sessions.   

In order to better address the research questions, the experimental protocol should be 

modified to support multiple test sessions and possibly use of a word prediction application at 

home. This would allow participants to practice and gain experience using the system. 

Performance should be tracked at intervals to determine if patterns or sequences of behavior are 

developing and if quantitative measures of performance show improvement.  
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Physical ability of the participants should be assessed in a quantitative manner allowing 

data for participants to be grouped for the purpose of performing comparisons. In this manner the 

able-bodied group would not necessarily be defined as able-bodied but would be defined 

according to ability and could possibly include participants with disabilities that do not affect 

computer use. Perhaps Compass could be used to perform this assessment. More participants 

with disabilities should be recruited. Confidence intervals could be computed for each group and 

then compared to examine the effect of ability as opposed to the comparisons performed in this 

study which examined each participant with a disability individually.  

In the event that comparisons are desired between actions used to perform different types 

of keystroke events, the test bench software must be modified to induce a greater number of 

events such as fix and transition keystrokes. Additionally, consideration should be given to the 

distribution of typing condition relative to the number of trials completed by each participant.  

The test bench could also be modified to present individual words for transcription 

instead of sentences. This would support the computation of text entry rate on a per word basis 

and allow more detailed comparisons between typing conditions. With the proposed 

modification, the use of word prediction would be determined on a per word basis depending on 

detection of a fixation on the word prediction list. In the test bench setup used for this study, data 

was partitioned based on word prediction being enabled, not on whether it was used. Text entry 

rate could only be calculated on a per sentence basis due to the appearance of the sentence in its 

entirety and the desire to include time for cognition in the text entry rate, i.e. the participant 

could have read three words then transcribed each from memory. The cognitive time related to 

reading and transcribing a single word could not be isolated.    
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APPENDIX A: TEXT ENTRY INTERFACE OUTPUT 

Subject Name = example data 
 
Sentence Group: 
Start Sentence = 1 
End Sentence = 5 
 
Configuration: 
Show Word Prediction List when 0 letter(s) is/are typed  
Hide Word Prediction List when 20 letter(s) is/are typed after the list is 
displayed 
Max List size = 5 
Min Word Size = 1 
 
Target Sentences are :  
Sentence number 1 is -> i agree with you the music is better than it sounds 
Sentence number 2 is -> fish are jumping neither a borrower nor a lender be 
Sentence number 3 is -> play it again sam please provide your date of birth 
Sentence number 4 is -> the cotton is high my favorite subject is psychology 
Sentence number 5 is -> the living is easy never too rich and never too thin 
 
Simulation parameters are :  
 
Initial Time = 1166110519044  -> this is the time in milliseconds since the 
start of the Unix epoch (January 1, 1970, 00:00:00 GMT) 
Type: (from eventRecord) 
 INCORRECTFIXED = 0; 
 INCORRECTNOTFIXED = 1; 
 FIX = 2; 
 WPSELECTION = 3; 
 LETTER = 4; 
 SPACE = 5; 
 TRANSITION = 6; 
 PAUSE_START = 7; 
 PAUSE_END = 8; 
 KEY_UP = 9; 
 IGNORED = 10; 
 
Text: input text from this event 
 
WPL Len: number of entries in the wp list 
 
WPL Disp: wp list displayed? t/f 
 
Total Time: time since start of trial 
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WPL Contents: entries in wp list 
 
Type Text WPL Len WPL Disp Total Time WPL Contents 
7  0 false 11203  
8  0 false 16266  
4 i 8 true 17500 the that you they this take time think  
9  0 false 17579  
9  0 false 17610  
5 _ 0 true 19219  
9  0 false 19329  
4 a 8 true 20954 the that you they this take time think  
9  0 false 21157  
4 g 2 true 21844 and are  
9  0 false 21954  
4 r 2 true 22016 again ago  
9  0 false 22141  
3 ee 2 true 23329 agree agreed  
9  0 false 23422  

. 

. 
Total Searches: 32 -> number of times the word prediction list appeared 
The following keystroke measures are defined in Soukoreff and MacKenzie 
(2004). 
Total Keystrokes: 32 -> total number of keystrokes entered  
 Correct: 51.0 -> alphanumeric keystrokes that are not errors 
 Incorrect Not Fixed: 0 errors that appear in the transcribed text.0 ->  
 Incorrect Fixed: 0 -> errors in the input stream that are corrected in  
        the transcribed text 
 Fixes: 0 -> 
The following metrics are defined in Soukoreff and MacKenzie (2003). 

keystrokes that perform corrections (backspace) 

MSD Error Rate = 0.0 -> minimum string distance – minimum number of 
primitives required to transform the transcribed string into the presented 
string 
KSPC = 0.6274509803921569 -> keystrokes per character – length of the input 
stream / length of the transcribed text 
 
TER = 1.4440433212996389 –> text entry rate in characters per second 
--- 
 
The same data appears for each of the five sentences. 
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APPENDIX B: MORAE CONFIGURATION 

Each recording file contains data for either a single block of five sentences or two blocks 

depending on how fast the sessions were being completed. The decision to partition the data into 

multiple files was made based on convenience, not limitations in the recording length. As 

mentioned in a previous section, the recommended screen resolution for use with the recorder is 

1024x768. Figure 51 and Figure 52 are screen shots of the Morae Recorder; the configuration 

used for all of the participants is shown. Settings appear in the main window while a preview of 

the webcam is shown in the pane to the right. The configuration includes specification of 

filename, folder, capture options, and recording initiation and termination.  
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Figure 51. Screen shot of first half of Morae recorder configuration 
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Figure 52. Screen shot of second half of Morae recorder configuration 
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APPENDIX C: DQW OUTPUT FILES 

Point of regard and fixation data were stored for each group of five sentences. The following is 

an example of the point of regard data output with comments in bold.   

 

ISCAN Tab-Delimited ASCII Data File 
Version 4.00 
 
ISCAN Data Recording 
 
Runs Recorded:  1 
Samps Recorded: 13401 
 
RUN INFORMATION TABLE 
Run # Date      Start Time Samples Samps/Sec Run Secs Image File  
 Description 
   1  2006/12/14  14:22:54   13401      60     223.35 
full_screen_ab.igr -> this is the name of an image registration file   
 
DATA SUMMARY TABLE 
POR H1AB -> point of regard horizontal (x coordinate on screen) considering 
gaze of both eyes  
POR V1AB -> point of regard vertical (y coordinate on screen) considering 
gaze of both eyes  
                Raw       Raw        
Run # Param     Mean      StdDev     
   1  
      POR H1AB    126.13    47.7277 
      POR V1AB    365.29    75.4069 
 
DATA INFO 
   x  y coordinates 
Run   1: POR H1AB  POR V1AB   
Sample # (Raw)     (Raw)      
       0    74.50   247.00 
       1    74.50   246.00 
       2    75.00   246.50 
       3    75.50   248.00 
       4    75.50   250.50 
       5    76.00   253.00 
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Fixation data was generated based on the point of regard data and a fixation time setting of 40 

milliseconds. The following is an example of the fixation data output with comments in bold. 

 

ISCAN P.O.R. Fixation Data File, Version 2.1 
calibration -> job name/ #  (from run event sequence file) 
test -> job type (from run event sequence file) 
0 
0 
Pitt -> test location (from run event sequence file) 
1 30 2006 -> date 
200 2600 222 
60 
442 0 3 3 
512 512  -> overall resolution  (from image registration file)   
130 390  -> registration point coordinates x y  (upper left) 
366 263  -> registration point coordinates x y  (upper right) 
192 329  -> registration point coordinates x y  (lower left) 
359 316  -> registration point coordinates x y  (lower right) 
full_screen_ab.igr -> image registration file identified in the run event 
sequence file 
1 0 13401 -> file shown 1 time, captured starting at sample 0, captured 13401 
samples 
fixation data -> start sample #, end sample #, x coordinate, y coordinate 
233 234 416 289  -> start sample = 233, end sample = 234, x = 416, y = 289 
235 237 404 294 
277 278 18 289 
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APPENDIX D: PRZ – DETAILS OF USE 

The application is run both before and after the actual collection of data. Prior to data collection 

with DQW, PRZ is used to create image registration and run event sequence files. Image 

registration files identify bitmap images and specific coordinates on them that serve as 

registration points. These registration points, when combined with the registration points in the 

DQW application, provide the information necessary to create scale factors used to map the 

collected data onto the image for viewing purposes. The image registration files are used by the 

PRZ program for the display of collected data. The following is an example image registration 

file with comments in bold. 

 
ISCAN Image Registration File, Version 1.0 
 
C:\subject_data\wpgui_std\full_screen_ab.bmp -> absolute path to the bitmap 
512 392 -> size of display 
126 67 386 67 127 323 386 323 -> coordinates of the registration points 
 

The run event sequence files are used to provide configuration information needed by the DQW 

program in order to generate fixation data. The following is an example run event sequence file 

with comments in bold. 

 

ISCAN Image Sequence Data File, Version 2.0 
Initials -> job name/ #   
data collection -> job type  
0 
0 
Pitt -> test location   
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1 120 -> respondent id # range - minimum and maximum 
0 
1 -> number of images in the sequence = runs limit in dqw 
full_screen_ab.igr -> list of registered images included in the run event 
sequence 

 

Following data collection with DQW, fixation data can be analyzed and viewed with PRZ. 

Figure 53 is a screen shot of the defined elements of interest on the registered image. 

 

Figure 53. Screen shot of PRZ showing defined areas of interest 

 

Areas of interest are defined as being slightly larger than the actual windows to accommodate 

poor calibration and drift as the ISCAN machine heats up. Figure 11 shows a screen shot of the 

PRZ display showing fixations identified from collected data overlaying the registered bitmap. 

Figure 54 shows the same output without the saccades. 
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Figure 54. PRZ fixation viewing screen shot without saccades 

 

The following is an example fixation list created from collected data. 

 

INDIVIDUAL ANALYSIS - LIST OF ELEMENT FIXATIONS TABLE 
 
Job Name/#:  initials 
Project Type:  data collection 
Image Name:   
Element File:  full_screen_std.emt 
Fixation File: as_wp_01_fix.fxn 
Respondent ID: 1 
View #:  1 of 1 
 
   Individual Element Fixations in Order 
 
                                                Start    Fixation 
Fixation    Element          X         Y        Time     Duration 
 Number      Name         Position  Position    (Sec)     (Sec) 
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     0   on-screen keybo    141       345        0.00       0.13 
     1   on-screen keybo    128       348        0.15       0.02 
     2   on-screen keybo     81       344        0.18       0.38 
     3   on-screen keybo     61       338        0.58       0.03 
     4   on-screen keybo     70       336        0.63       0.03 
     5   on-screen keybo     79       337        0.68       0.02 
     6   on-screen keybo     90       337        0.72       0.03 
     7   on-screen keybo    122       341        0.77       0.53 
     8   transcribed tex     65       257        1.57       0.13 
     9   on-screen keybo     49       341        1.95       0.32 
    10   on-screen keybo    124       348        2.30       1.68 
    11   on-screen keybo     58       360        4.00       0.38 
    12   on-screen keybo     93       348        4.40       0.28 
    13   transcribed tex    118       238        4.75       0.02 
    14   transcribed tex    119       240        4.78       0.02 
    15   transcribed tex    101       226        4.88       0.02 
    16   No Element          78       211        4.97       0.03 
    17   target text         71       205        5.02       0.02 
    18   target text         55       194        5.10       0.03 
    19   on-screen keybo     86       343        5.55       1.82 
    20   target text         41       183        7.80       0.02 
    21   target text         37       185        7.83       0.02 
    22   on-screen keybo     70       337        8.27       0.40 
    23   wp list             34        23        8.75       0.02 
    24   wp list             33        30        8.78       0.68 
    25   on-screen keybo     41       308        9.88       0.08 
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APPENDIX E: DATA COLLECTION SETUP 

Subject’s PC

• Remove old wp log files 
o C:\test_bed\WPJava 
o del *.wp 

• Copy entire c:\test_bed\ subject_data\initials folder  
o rename based on subject’s initials 
o delete folders that will not be used based on tests listed in subject_summary.xls 

(latin square) 
• Start the Morae Recorder 

o File->Open Configuration 
 C:\test_bed\subject_data\initials\morae_record_config.mrcfg 
 Save recording as: 

• Initials   (will append configuration_sentences to each) 
 Folder: 

• C:\test_bed\subject_data\initials\ 
o File->Save Configuration As 

 initials_morae_record_config.mrcfg 
• Start the HDD USB Monitor 

o Open c:\test_bed\subject_data\mouse_usb_monitor or trackball_usb_monitor 
o Initiate capture  [F9] 
o Move the mouse or trackball to confirm operational 
o Stop capture  [F12] 
o Export  [ctrl + e]  c:\ test_bed\subject_data\initials\test.html 
o (this will set up directory for saving, can discard test file later) 
o Clear the view [Delete]  
o Resize the window so that it fits behind the wpgui window 

• Open a DOS window to c:\test_bed\WPJava\ 
o Run the word prediction test bed 

 java –classpath “.” wpgui 
• Start the on screen keyboard  

o Note: keyboard selection will actually be based on a cutoff text entry rate during 
the practice trials.  If a subject types at less than 0.65 char/sec (8 words/min) with 
the standard on-screen keyboard then WiViK will be used.   

o If for some reason the desktop shortcut is gone:  
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 Start->All Programs->Accessories->Accessibility->On-Screen Keyboard 
o Select Keyboard->Standard Layout 
o Unselect Settings->Always on Top 
o Align the keyboard along the lower left corner of the screen above start 

OR 

o Start WiViK 
 Keyboard – USENGLSH_SIMPLE.KBP 

• After positioning the on-screen keyboard against the task bar, auto hide the task bar to 
prevent the subject from accidentally opening another window.   

• Start Atomic Clock Sync [ctrl + alt + a] 
o Ping Now 

 This will synchronize the clock setting 
o Close Atomic Clock Sync 

• Open calibrate.ppt and show slide show (F5) 
 

ISCAN PC 

• Copy entire c:\test_bed\ subject_data\initials folder  
o rename based on subject’s initials 
o delete folders that will not be used based on tests listed in subject_summary.xls 

(latin square) 
• Start Atomic Clock Sync 

o Ping Now 
 This will synchronize the clock setting 

o Close Atomic Clock Sync 
• Start DQW1_11A 

o File->Open ISCAN Run Event Seq File-> 
 c:\subject_data\wpgui_std\wpgui.seq OR  
 c:\subject_data\wpgui_wivik\wpgui.seq 

o Maximize VIDEO 1 by checking the box at the upper right  
o Select Options [button is near the bottom of the screen, in the middle] 

 Keep hitting button until POR CALIBRATION CONTROLS appears to 
the left 

o Select the POR 1 tab 
 Click the POR Calibrate radio button 

• Place each of the calibration markers over the corresponding 
marker on calibrate.ppt shown in the video 1 expanded view 

o Use the Select Point button to move from one marker to the 
next 

 Click the Image Reg radio button 
• Place each of the registration markers over the corresponding 

marker on calibrate.ppt shown in the video 1 expanded view [there 
is no center registration marker] 
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o Use the Select Point button to move from one marker to the 
next 

 Click on the Reset radio button 
o Select the Options button (bottom of the screen) until DATA RECORDING 

CONTROLS appears to the left 
 Select the Bank 1 tab  
 Confirm the following: 

• 01 -> .POR.H1AB  (point of regard for both eyes, horizontal) 
• 02 -> .POR.V1AB  (point of regard for both eyes, vertical) 

 Select the Record tab 
• Confirm the following: 

o Trigger check box is checked -> Internal 
o Runs Rec’d -> 0 (if not Delete Last) 
o Runs Limit -> 1 
o 60 Hz All Pts 

 

Subject’s PC

• Close calibrate.ppt   
• Open the Morae Recorder and check the camera preview to be sure the web cam is 

positioned properly 
• Open seq_calibrate.ppt  [ctl + alt + c] 

o Start the slide show (F5) 
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APPENDIX F: CONSENT FORM 
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APPENDIX G : PRELIMINARY QUESTIONNAIRE – TRANSCRIPTION STUDY 
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APPENDIX H: CONSUMER SURVEY 
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APPENDIX I : CALIBRATION PROCEDURE 

ISCAN PC 

• Position the subject’s eyes in the VIDEO 2 display 
o Can manually adjust camera position / height and use P/T Control (pan/tilt) 
o Center the subject’s eyes in the display 
o Allow space for slight horizontal head movement 

• Check the Track Active check box (bottom near the middle of the window) 
• Click on the Tracks button until EYE TRACKING CONTROL (1,2) appears in the upper 

left 
• Select the Eye 1 Tab 

o Check the following check boxes: 
 Threshold 
 Pupil X-Hairs 
 C.R. X-Hairs 
 C.R. Limit 

o The subject’s pupils should appear white with black crosshairs; the corneal 
reflections should appear as black dots with white crosshairs.  

  If the crosshairs are not visible for both eyes: 
• Uncheck the Auto check box 
• Manually adjust the Pupil and C.R. sliders to set the boundaries of 

the pupils and the corneal reflections.   
• Select the POR Calibrate radio button in the POR CALIBRATION CONTROLS POR 1 

tab 
o Ask the subject to focus on the marker on the first slide 
o Confirm that the crosshairs appear over BOTH eyes 
o Enter Calib Pt 
o The marker should automatically move to the next calibration point 

 

Subject’s PC

o Advance to the next slide in the slide show (can left click the mouse or  enter) 
 

ISCAN PC 
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o Ask the subject to focus on the marker on the slide 
o Confirm that the crosshairs appear over BOTH eyes 
o Enter Calib Pt 
o The marker should automatically move to the next calibration point 
o Continue the process for the remaining three calibration points 

• Select the Reset radio button 
o The POR Output radio button should become active 

 If the POR Output radio button does not become active: 
• Repeat the calibration procedure, making absolutely certain that 

BOTH sets of crosshairs appear over BOTH eyes! 
• Select the POR Output radio button 
• Ask the subject to look up, down, left and right, confirming that the marker on the 

VIDEO 1 EXPANDED VIEW follows the direction of their gaze 
o If the marker does not follow the direction of their gaze: 

 Repeat the calibration procedure, making absolutely certain that BOTH 
sets of crosshairs appear over BOTH eyes! 

• At this point the marker on the VIDEO 1 EXPANDED VIEW should be tracking the 
subject’s gaze 

o If it is not: 
 Consider adjusting the angle of the camera relative to their eyes  
 Note that if the subject is wearing glasses: 

• The glare will be worst when the lenses are perpendicular to the 
plane of the camera, try to adjust the angle of the lenses!   

• Ask the subject to put their chin down 
• Move the glasses slightly up or down the nose 

 Repeat the calibration procedure using dark_calibrate.ppt, making 
absolutely certain that BOTH sets of crosshairs appear over BOTH eyes! 

• File->Save ISCAN POR Calib File As->  
o c:\subject_data\subject_name\initials_por_calib.pcl 
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APPENDIX J: PRACTICE PROCEDURE 

Subject’s PC

• Close seq_calibrate.ppt  [alt + space, c] 
• Allow the subject to do a practice session consisting of the last sentence group in their 

sequence with word prediction enabled.  The subject may transcribe as many of the 
sentences in the group as they wish to support acclimation to the test environment.   

o File->Parameters->Word Prediction tab 
• Word Prediction Active:  true  

o select the desired Sentence Group via the menu 
o Instruct the subject to enter the target sentence via the on-screen keyboard and not 

to position the mouse in the transcribed text field.   
o Instruct the subject not to lift the mouse for repositioning. 
o Instruct subject to only use the white keys on the keyboard, no arrows for 

positioning within the text field. 
o Inform the subject that it is his or her choice as to whether to correct errors or not.   
o Instruct the subject to hit the on-screen keyboard enter key when a sentence is 

complete.   
o Explain how to select items from the word prediction list and specifically mention 

that a selected item includes the space following the word. 
o Mention that during the data collection some sentence groups will be entered via 

letters only typing and others will be entered with word prediction enabled.  
o Ask the subject to hold his or her head still while transcribing the text.  Explain 

that there is room for very slight head movement.     
o Explain the pause and 3 beeps between sentences.   
o Reiterate that the subject may do as many sentences as they wish to become 

acclimated to the test environment, stress that we would like at least 2 complete 
sentences to use for a TER check 

o File->Start Trial 
 

ISCAN PC 

• Monitor the VIDEO 2 display to be sure that the subject’s eyes remain in view and the 
crosshairs remain over both eyes until the subject finishes practicing 

o Click the P/T Control Auto radio button to allow the software to perform the 
adjustments 
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• NOTE – do not record data for this practice trial, give the subject feedback on head 
positioning and movement 

• When the subject has completed the practice trials unclick the track active check box 
• Select the Options button (bottom of the screen) until DATA RECORDING CONTROLS 

appears to the left 
o Delete Last to remove old data 
o Confirm Runs Rec’d -> 0 

 

Subject’s PC

• Note: check the text entry rate (TER) for the practice sentences.  If TER < 0.65 char/sec 
(8 words/min) then switch to the WiViK on-screen keyboard and do another practice 
trial.  If the keyboard is switched then we MUST load the other sequence file in the 
ISCAN DQW application!!!!!!!! 

• Insert the subject’s name in the parameters dialog 
o File->Parameters->Trial tab 

 Subject Name:  subject_name 
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APPENDIX K: DATA COLLECTION PROCEDURE 

• Start the Morae Recorder 
o Start data collection [ctrl + alt + f9] 

• Word Prediction Testbed 
 File->Parameters->Word Prediction tab [alt + f, p] 

• Word Prediction Active:  true or false 
 select the desired Sentence Group [alt + s, down arrow] 

• Start USB sniffer   
o [alt + tab] make window active 
o [F9] start capture 
o Move subject’s mouse to upper left of screen (0,0) and right click 5 times 
o Move subject’s mouse back down to the wpgui and left click to make it the active 

window (and hide the usb sniffer) 
 

ISCAN PC 

• Check the Track Active check box (bottom near the middle of the window) 
• Click the P/T Control Auto radio button to allow the software to perform adjustments that 

will accommodate slight head movement. 
 

Subject’s PC

• Word Prediction Testbed  
o Start the trial [alt + f, s] 

 

ISCAN PC 

• DATA RECORDING CONTROLS Record Tab 
o Click on the Start Record radio button 

• Monitor the VIDEO 2 display to be sure that the subject’s eyes remain in view and the 
crosshairs remain over both eyes until the subject completes the trial 

• WHEN THE SUBJECT HAS COMPLETED THE SENTENCE GROUP…  
• DATA RECORDING CONTROLS Record Tab 
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o Click on the Quit Record radio button 
• Uncheck the Track Active check box (bottom near the middle of the window) 
• IF CONTINUING IMMEDIATELY TO THE NEXT SENTENCE GROUP: 
• File->Save ISCAN Raw Data File As->  [alt + f, a] 

o c:\subject_data\subject_name\ initials_configuration_sentences_raw 
• File->Save ISCAN POR Fixation File As->  

o Choose Fixation Parameters 
 #1 – POR Calib 
 Source AB 
 Continue >> 

o Enter Respondent ID Info 
 New ID# 

• xy 
 Enter Track ID (n, a->f) 

• n 
 Finish 

o Save in: 
 c:\subject_data\subject_name 

o File name: 
o initials_configuration_sentences_fix  
o Save as type: 

 ISCAN POR Fixation Files (*.fxn) 
• Open folder c:\subject_data\subject_name 

o Confirm the following are present: 
 initials_configuration_sentences_raw.dqw 
 initials_configuration_sentences_fix.fxn 

• Select the Options button (bottom of the screen) until DATA RECORDING CONTROLS 
appears to the left 

o Delete Last to remove old data 
o Confirm Runs Rec’d -> 0 

• Check the Track Active check box (bottom near the middle of the window) 
• ELSE: 
• Subject can relax and move out of view of the camera 

 

Subject’s PC

• IF CONTINUING IMMEDIATELY TO THE NEXT SENTENCE GROUP: 
• Word Prediction Testbed 

o Select the next sentence group for the subject [alt + s, down arrow] 
o Start the trial [alt + f, s] 

• ELSE: 
• Stop USB sniffer   

o [alt + tab] make window active 
o [F12] stop capture 
o [ctrl + e] Export to file subject_name_configuration_sentences_usb.html  
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o Confirm the data file was written 
o Clear the view [Delete]  

• Morae Recorder 
o Stop recording  [ctrl + alt + f9] 
o Recording File Details 

 Save recording as: 
• subject_name_configuration_sentences  

 Folder: 
• c:\test_bed\subject_data\ subject_name\ 

 Add any relevant notes in the description 
 OK 
 File->Exit 

• Atomic Clock Sync 
o Ping Now 

 This will synchronize the clock setting 
 

ISCAN PC 

• File->Save ISCAN Raw Data File As->  [alt + f, a] 
o c:\subject_data\subject_name\ initials_configuration_sentences_raw 

• File->Save ISCAN POR Fixation File As->  
o Choose Fixation Parameters 

 #1 – POR Calib 
 Source AB 
 Continue >> 

o Enter Respondent ID Info 
 New ID# 

• xy 
 Enter Track ID (n, a->f) 

• n 
 Finish 

o Save in: 
 c:\subject_data\subject_name 

o File name: 
o initials_configuration_sentences_fix  
o Save as type: 

 ISCAN POR Fixation Files (*.fxn) 
• Open folder c:\subject_data\subject_name 

o Confirm the following are present: 
 initials_configuration_sentences_raw.dqw 
 initials_configuration_sentences_fix.fxn 

• Select the Options button (bottom of the screen) until DATA RECORDING CONTROLS 
appears to the left 

o Delete Last to remove old data 
o Confirm Runs Rec’d -> 0 
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• Atomic Clock Sync  
o Ping Now 

 This will synchronize the clock setting 
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APPENDIX L: DATA STORAGE PROCEDURE 

Network Drive

• Copy L:\Simpson Lab\Jen\subject_data\subject_name 
o Rename with subject’s initials 
o L:\Simpson Lab\Jen\subject_data\initials 

• Should have 2 sub-folders 
o L:\Simpson Lab\Jen\subject_data\initials\subject_pc 
o L:\Simpson Lab\Jen\subject_data\initials\iscan_pc 

 

Subject’s PC

• Copy c:\test_bed\WPJava\*.wp c:\ test_bed\subject_data\ subject_name\wpgui_out 
• Copy c:\test_bed\WPJava\ inititalsx.wp to c:\ test_bed\subject_data\ 

subject_name\initials_ configuration_sentences.wp 
• Word Prediction Data 

o Open c:\test_bed\subject_data\ subject_name\initials_ 
configuration_sentences.wp with Wordpad and confirm there is data. 

• HHD USB Monitor data 
o Open c:\test_bed\subject_data\ subject_name\ 

initials_configuration_sentences_usb.html (can save as a text file) and confirm 
there is data (timestamp and many mouse movement events). 

• Recording Data 
o Start Morae Manager 

 Create a new project 
 Project name: 

• morae_project_initials_configuration_sentences 
 Project folder: 

• c:\test_bed\subject_data\subject_name\ 
 Next 
 Add 

• c:\test_bed\subject_data\subject_name\ 
subject_name_configuration_sentences .rdg 

• Open 
 Finish 
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 Should see recording 
 File->Exit 

• Copy c:\test_bed\subject_data\subject_name\*   L:\Simpson 
Lab\Jen\subject_data\initials\subject_pc\ 
 

 

ISCAN PC 

• Start PRZ1_02E 
o Module – Image Element Entry->Individual Analysis 
o File->Open-> 

 Look in: 
• c:\subject_data\wpgui_std\ or c:\subject_data\wpgui_wivik 

 File name: 
• full_screen_std or full_screen_wivik 

 Files of type: 
• Image Element Files (*.EMT) 

 Open 
o A bitmap with the word prediction application main window, word prediction list 

dialog and the onscreen keyboard should appear.  Rectangles outline areas of 
fixation interest. 

o In the INDIVIDUAL ANALYSIS INFO pane to the left: 
 Element File Name:  full_screen_std.emt 
 Reg Image File Name:  wpgui_kb_std.igr OR wpgui_kb_wivik.igr 
 Image:  wpgui with keyboard 

o File->Open-> 
 Look in: 

• c:\subject_data\ subject_name\ 
 File name: 

• initials_configuration_sentences_fix 
 Files of type: 

• POR Fixation Data Files (*.FXN) 
 Open 

o Fixations should appear superimposed on the bitmap. 
o In the INDIVIDUAL ANALYSIS INFO pane to the left: 

 Fixation File Name:  initials_configuration_sentences_fix.fxn 
 The RUN INDIVIDUAL ANALYSIS button should be active 

o Click on the RUN INDIVIDUAL ANALYSIS button 
o View->List of Element Fixations 
o The display should show a list of individual element fixations in order. 
o File->Saved Table Style->Formatted ASCII 
o File->Save Displayed Table As-> 

 c:\ subject_data\ subject_name\ 
 initials_configuration_sentences_fix_list.txt 
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o File->Exit Program 
• Copy all fixation files to c:\ subject_data\ subject_name\fixation_out\ 
• Copy c:\test_bed\subject_data\subject_name\*   L:\Simpson 

Lab\Jen\subject_data\initials\iscan_pc\ 
 

Network Drive

• Contents: 
o L:\Simpson Lab\Jen\subject_data\initials\subject_pc 

 \wpgui_out\  [all wpgui output files] 
 initials_morae_record_config.mrcfg  [morae recorder config] 
 For each configuration + sentence combination  

• initials_configuration_sentences.wp 
• initials_configuration_sentences_usb.html 
• initials_configuration_sentences.rdg 
• \ morae_project_initials_configuration_sentences\  [entire folder] 

o L:\Simpson Lab\Jen\subject_data\initials\iscan_pc 
 For each configuration + sentence combination  

• initials_configuration_sentences_fix_list.txt  
• initials_configuration_sentences_fix.fxn 
• initials_configuration_sentences_raw.dqw 

 initials_por_calib.pcl [will only appear when calibration was done, not for 
every sentence group] 
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APPENDIX M: POST PROCESSING PERL SCRIPTS 

M.1 PARSE_WORD_DATA_FILES.PL 

This script is run by the following command line: 

perl parse_word_data_files.pl absolute_path_to_directory_containing_files 

Files in the specified directory should include any number of the following: 

configuration_sentencegroup.wp 

configuration_sentencegroup_raw.tda 

configuration_sentencegroup_fix_list.txt 

The script runs the following command line for each .wp file in the specified directory: 

perl parse_word_data.pl   configuration_sentencegroup.wp 

This script synchronizes the data from the configuration_sentencegroup.wp and 

configuration_sentencegroup_fix_list.txt. Note that configuration_sentencegroup_raw.tda is 

only used to provide an initial timestamp for the ISCAN data.  Only data for words entered free 

of errors is included in the output file due to the complexity of maintaining an awareness of what 

the subject believes the target word is. When something unexpected occurs in the input stream it 

is difficult to identify the subject’s intent. The following shows the format of the output file, 

word_data.xls followed by an example. 
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# column A - target sentence # 
# column B - target word 
# column C - target word length 
# column D - target char 
# column E - target char position in word 
# column F - is target word in word prediction list?  [remember this is the 
list prior to the current char entry!] 
# column G - duration of word prediction list fixations during the time 
interval associated with entry of this char 
# column H - was word prediction used?  
# column I - duration of target text fixations during the time interval 
associated with entry of this char 
# column J - duration of transcribed text fixations during the time interval 
associated with entry of this char 
# column K - duration of on-screen keyboard fixations during the time 
interval associated with entry of this char 
# column L - string of codes indicating the sequence of events which occurred 
during entry of the character 
 # 
 # character event codes: 
 # 0 - reserved - no event 
 # 1 - target text fixation 
 # 2 - transcribed text fixation 
 # 3 - word prediction list fixation 
 # 4 - on-screen keyboard fixation 
 # 5 - character entered 
 # 6 - number entered for word prediction selection 
 # 
# column M - the time from PAUSE_END(8) or KEY_UP(9) to WPSELECTION(3) or 
LETTER(4) = time between keystrokes (seconds) 
# column N - number of word prediction list fixations during the time 
interval associated with entry of this char 
# column O - number of presented (target) text fixations during the time 
interval associated with entry of this char 
# column P - number of transcribed text fixations during the time interval 
associated with entry of this char 
# column Q - number of on-screen keyboard fixations during the time interval 
associated with entry of this char 
# column R - positive search -> list search when word was in the list 
# column S - false positive search -> list search when word was not in the 
list 
# column T - negative search -> no list search when word was not in the list 
# column U - false negative search -> no list search when word was in the 
list 
# column V - successful search -> target word selected during search when 
target word was in the list 
# column W - unsuccessful search -> target word not selected during search 
when target word was in the list 
# column X - number of words in wp list 
# 
 

A 56 56 56 56 56 56 56 56 56 56 

B see see see you you you later later later later 
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C 3 3 3 3 3 3 5 5 5 5 

D s e e y o u l a t e 

E 1 2 3 1 2 3 1 2 3 4 

F 0 1 1 0 1 1 0 0 1 1 

G 0 0 0 0 0 0 0.03 0 0 0.33 

H 0 0 1 0 0 1 0 0 0 1 

I 0 0 0 0.07 0 0 0 0 0 0 

J 0 0 0 0 0 0 0.02 0 0 0 

K 1.22 0 0.15 2.17 0 0 0.02 0 1.13 0 

L 545 55 546 145 5 6 32455 55 45 536 

M 1.454 0.484 0.859 1 0.687 1.204 1.156 0.656 0.906 1.25 

N 0 0 0 0 0 0 1 0 0 3 

O 0 0 0 1 0 0 0 0 0 0 

P 0 0 0 0 0 0 1 0 0 0 

Q 1 0 1 2 0 0 1 0 1 0 

R 0 0 1 0 0 1 0 0 0 1 

S 0 0 0 0 0 0 1 0 0 0 

T 1 0 0 1 0 0 0 1 0 0 

U 0 1 0 0 1 0 0 0 1 0 

V 0 0 1 0 0 1 0 0 0 1 

W 0 0 0 0 0 0 0 0 0 0 

X 5 5 5 5 5 5 5 5 5 5 

 

M.2 CREATE_LIST_SEARCH_SUMMARY.PL 

This script is run by the following command line: 
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perl create_list_search_summary.pl word_data.xls 

This script summarizes information concerning list searches on a per sentence basis. The 

following shows the format of the output file, search summary.xls followed by an example. 

 

# 
# column A - sentence # 
# column B - # positive list searches - User searched list when word was in 
list 
# column C - duration of positive list searches 
# column D - positive list search time (column C / column B) --- time for a 
single positive list search 
# column E - # false positive list searches - User searched list when word 
was not in list 
# column F - duration of false positive list searches 
# column G - false positive list search time (column F / column E) --- time 
for a single false positive list search 
# column H - # negative list searches - User did not search list when word 
was not in list 
# column I - duration of negative list searches 
# column J - negative list search time (column I / column H) --- time for a 
single negative list search 
# column K - # false negative list searches - User did not search list when 
word was in list 
# column L - duration of false negative list searches 
# column M - false negative list search time (column L / column K) --- time 
for a single false negative list search 
# column N - successful anticipation - (Positive searches + Negative 
searches)/(total searches) 
# column O - # successful searches - User selected the target word during a 
search in which the target word was displayed in list 
# column P - duration of successful searches 
# column Q - successful list search time (column P / column O) --- time for a 
single successful list search 
# column R - # unsuccessful searches - User did not select the target word 
during a search in which the target word was displayed in list 
# column S - duration of unsuccessful searches 
# column T - unsuccessful list search time (column S / column R) --- time for 
a single unsuccessful list search 
# column U - # presented text fixations 
# column V - duration of presented text fixations 
# column W - # transcribed text fixations 
# column X - duration of transcribed text fixations 
# column Y - # on-screen keyboard fixations 
# column Z - duration of on-screen keyboard fixations 
# 
 

A 56 57 58 59 60 
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B 6 7 5 1 0 

C 1 0.45 0.6 0.52 0 

D 0 0.064 0.12 0.52 0 

E 5 4 6 1 1 

F 1 1.28 1.79 0.25 0.05 

G 0 0.32 0.298 0.25 0.05 

H 14 15 7 2 0 

I 0 0 0 0 0 

J 0 0 0 0 0 

K 3 7 4 1 0 

L 0 0 0 0 0 

M 0 0 0 0 0 

N 1 0.667 0.545 0.6 0 

O 6 4 2 1 0 

P 1 0.12 0.02 0.52 0 

Q 0 0.03 0.01 0.52 0 

R 0 3 3 0 0 

S 0 0.33 0.58 0 0 

T 0 0.11 0.193 0 0 

U 4 9 6 2 0 

V 0 0.37 0.82 0.05 0 

W 6 13 10 0 0 

X 0 0.81 0.32 0 0 

Y 23 39 26 2 3 

Z 11 10.43 6.1 1.05 0.3 
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M.3 PARSE_ALL_SENTENCE_SUMMARY_DATA_FILES.PL 

This script is run by the following command line: 

perl parse_all_sentence_summary_data_files.pl  absolute_path_to_directory_containing_files 

The script runs the following command line for each .wp file in the specified directory: 

perl parse_sentence_summary_data.pl   configuration_sentencegroup.wp 

This script gathers keystroke summary information which includes all keystroke events and 

creates five output files. The format and an example of the data in each file are shown below. 

 
# file: name_keystrokes.xls 
# column A - sentence number 
# column B - wp active? 
# column C - number of correct keystrokes 
# column D - number of incorrect not fixed keystrokes 
# column E - number of incorrect fixed keystrokes 
# column F - number of fix keystrokes 
# column G - % correct keystrokes = C/(C+INF+IF+F) 
# column H - correct keystrokes to total text-producing keystrokes = 
C/(C+INF+F) 
# column I - % errors = (INF+IF)/(C+INF+IF+F) 
# column J - errors to total text-producing keystrokes = (INF+IF)/(C+INF+F) 
# column K - participant conscientiousness = IF/(IF+INF) 
# column L - utilised bandwidth = C/(C+INF+IF+F) 
# column M - wasted bandwidth = (INF+IF+F)/(C+INF+IF+F) 
# column N - total error rate = (INF+IF)/(C+INF+IF) x 100 
# column O - not corrected error rate = INF/(C+INF+IF) x 100 
# column P - corrected error rate = IF/(C+INF+IF) x 100 
# 
 

A 56 57 58 59 60 

B TRUE TRUE TRUE TRUE TRUE 

C 53 51 54 51 52 

D 0 0 0 0 0 

E 1 1 5 5 0 

F 1 1 5 5 0 

G 0.963636 0.962264 0.84375 0.836066 1 
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H 0.981481 0.980769 0.915254 0.910714 1 

I 0.018182 0.018868 0.078125 0.081967 0 

J 0.018519 0.019231 0.084746 0.089286 0 

K 1 1 1 1   

L 0.963636 0.962264 0.84375 0.836066 1 

M 0.036364 0.037736 0.15625 0.163934 0 

N 1.851852 1.923077 8.474576 8.928571 0 

O 0 0 0 0 0 

P 1.851852 1.923077 8.474576 8.928571 0 

 

# file: name_keystroke_savings.xls 
# column A - sentence number 
# column B - wp active? 
# column C - length of presented text 
# column D - length of input stream 
# column E - length of transcribed text 
# column F - minimum keystrokes required (optimal wp use) 
# column G - keystroke savings compared to letters only (length of 
transcribed text)/(length of the input stream) 
# column H - keystroke savings compared to optimal letters only (length of 
presented text)/(length of the input stream) 
# column I - keystroke savings compared to optimal wp (minimum keystrokes 
required)/(length of the input stream) 
# 
 

A 56 57 58 59 60 

B TRUE TRUE TRUE TRUE TRUE

C 53 51 54 51 52 

D 41 46 59 48 40 

E 54 51 54 52 52 

F 35 35 37 33 31 

G 1.317073 1.108696 0.915254 1.083333 1.3 

H 1.292683 1.108696 0.915254 1.0625 1.3 
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I 0.853659 0.76087 0.627119 0.6875 0.775 

 

# file: name_text_entry_rate.xls 
# column A - sentence number 
# column B - wp active? 
# column C - text entry rate in chars / sec 
# 
 

A 56 57 58 59 60 

B TRUE TRUE TRUE TRUE TRUE 

C 1.457215 1.287065 1.132246 1.228182 1.706649

 

# file: name_keystroke_rate.xls 
# column A - sentence number 
# column B - wp active? 
# column C - number of keystrokes (including enter) 
# column D - time for trial in seconds (pause_end to enter) 
# column E - keystroke rate in keystrokes / sec 
# 
 

A 56 57 58 59 60 

B TRUE TRUE TRUE TRUE TRUE 

C 42 47 60 49 41 

D 37.057 40.402 48.576 42.339 31.055 

E 1.133389 1.163309 1.235178 1.157325 1.320238

 

# file: name_time_between_keystrokes.xls 
# column A - sentence number 
# column B - wp active? 
# column C - average time between keystrokes [key up to key down] in seconds 
# 
 

A 56 57 58 59 60 

B TRUE TRUE TRUE TRUE TRUE 
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C 0.840098 0.825696 0.774034 0.842333 0.726775

 

M.4 PARSE_ALL_DATA_FILES.PL 

This script is run by the following command line: 

perl parse_all_data_files.pl  absolute_path_to_directory_containing_files 

The script runs the following command line for each .wp file in the specified directory: 

perl parse_all_data.pl   configuration_sentencegroup.wp 

This script, which requires the same files as parse_word_data_files.pl, generates a file containing 

the event sequences that occur with each keystroke. All keystroke events are included in the 

output file all_data.xls. The following shows the format of all_data.xls followed by an example. 

 

# column A - event type (field 0 from the wp file) 
 # FIX = 2;  <Backspace> 
 # WPSELECTION = 3;   
 # LETTER = 4;   
 # SPACE = 5;   
 # TRANSITION = 6; <Enter>  
# column B - text (field 1 from the wp file) 
# column C - string of codes indicating the sequence of events which occurred 
during this keystroke 
 # 0 - no fixations found 
 # 1 - target text fixation 
 # 2 - transcribed text fixation 
 # 3 - word prediction list fixation 
 # 4 - on-screen keyboard fixation.  
 # 5 - no element fixation (fixation outside the defined areas of 
interest) 
# column D - delta time - time for this keystroke event 
 

A 4 3 4 4 3 4 4 3 4 4 4 4 3 
B d o n o t s a y a n y t hing 
C 4 24153 3 2 4 0 0 3 41 4 3 3 41 
D 1.282 1.000 0.704 0.609 0.688 0.766 0.187 0.985 0.719 0.672 0.578 0.500 0.812
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M.5 PARSE_SEQUENCE_DATA.PL 

This script is run by the following command line: 

perl parse_sequence_data.pl  all_data.xls 

The script creates summary statistics for event sequences. The following shows the format of the 

output file, sequence_summary.xls followed by an example.   

 

# column A - event type (field 0 from the wp file) 
 # FIX = 2;  <Backspace> 
 # WPSELECTION = 3;   
 # LETTER = 4;   
 # SPACE = 5;   
 # TRANSITION = 6; <Enter>  
# column B - string of codes indicating the sequence of fixations identified 
 # 0 - no fixations found 
 # 1 - target text fixation 
 # 2 - transcribed text fixation 
 # 3 - word prediction list fixation 
 # 4 - on-screen keyboard fixation 
 # 5 - no element fixation (fixation outside the defined areas of 
interest) 
# column C - number of times the string in column B occurred (throughout the 
entire file) 
# column D - probability of the string in column B occurring  
note - this is per event type and sequence length,  
ie. the number of times this particular x element sequence occurred / total 
number of x element sequence occurrences for a given event type 
 

A LETTER LETTER LETTER LETTER LETTER LETTER LETTER LETTER LETTER LETTER 
B 2 4 5 1 3 25 42 54 52 45
C 462 1177 340 291 397 65 90 84 81 116
D 17.32283 44.13198 12.74841 10.91114 14.88564 6.238004 8.637236 8.06142 7.773512 11.13244

 

The script generates a second output file, sequence_analysis.xls which contains the transitional 

probability matrices for each event type. Examples are provided. 
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 target transcribed 
wp 
List keyboard outside none f(first) 

target 0 4 8 21 6 18 57
transcribed 8 0 4 32 15 26 85
wp list 1 5 0 66 7 76 155
keyboard 16 29 38 0 22 160 265
outside 7 9 18 26 0 15 75
f(second) 32 47 68 145 50 295 637

 

 target transcribed 
wp 
list keyboard outside none f(first) 

target 0 6 23 85 16 161 291
transcribed 48 0 9 116 65 224 462
wp list 6 27 0 80 9 275 397
keyboard 47 90 54 0 116 870 1177
outside 49 81 31 84 0 95 340
f(second) 150 204 117 365 206 1625 2667
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APPENDIX N: Z-SCORE MATRICES 

N.1.1 Participant a 

 presented transcribed wp list keyboard outside none 
presented 0 -3.872 2.424 7.632 -0.925 -2.891 
transcribed 4.539 0 -3.865 6.882 5.574 -6.061 
wp list -4.718 -2.014 0 6.461 -4.791 0.767 
keyboard -3.871 -1.563 -0.505 0 0.386 2.096 
outside 6.920 11.7135 4.993 4.635 0 -10.681 

  

N.1.2 Participant b 

 presented transcribed wp list keyboard outside none 
presented 0 -1.180 -1.831 11.715 5.172 -7.199 
transcribed 5.713 0 -1.688 6.438 2.595 -5.658 
wp list -4.387 -4.645 0 7.749 4.231 -2.957 
keyboard -3.317 0.860 -1.425 0 -6.632 4.395 
outside 7.803 4.432 12.508 3.264 0 -10.560 
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N.1.3 Participant 1 

 presented transcribed wp list keyboard outside none 
presented 0 2.313 8.570 0.269 0.446 -4.726 
transcribed 0.694 0 -2.336 11.757 2.765 -8.244 
wp list 2.039 -4.064 0 3.366 -3.881 1.520 
keyboard -3.034 -4.360 0.859 0 0.854 2.349 
outside -0.034 11.192 -3.678 12.022 0 -11.818 

  

N.1.4 Participant 2 

 presented transcribed wp list keyboard outside none 
presented 0 2.066 0.917 0.948 0.722 -3.029 
transcribed 2.924 0 -0.942 -0.187 1.715 -2.708 
wp list 0.830 -1.460 0 2.543 0.198 -1.908 
keyboard -2.866 -0.827 -2.280 0 0.982 2.392 
outside 0.129 -0.500 1.228 3.819 0 -3.492 

  

N.1.5 Participant c 

 presented transcribed wp list keyboard outside none 
presented 0 5.862 3.839 -0.784 5.155 -6.923 
transcribed 2.445 0 -0.621 -3.433 -0.957 2.179 
wp list -0.348 -0.847 0 0.499 1.367 -0.575 
keyboard -6.073 5.175 -1.074 0 11.641 -9.786 
outside -0.702 6.828 -0.485 7.841 0 -9.334 
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N.1.6 Participant 3 

 presented transcribed wp list keyboard outside none 
presented 0 1.310 0.529 0.300 2.167 -2.954 
transcribed 6.316 0 -1.649 -1.823 4.880 -5.252 
wp list -1.127 -0.056 0 -0.814 0.288 0.914 
keyboard -6.144 -3.400 -2.624 0 9.862 -3.286 
outside -1.076 -0.310 0.457 10.042 0 -7.619 

  

N.1.7 Participant d 

 presented transcribed wp list keyboard outside none 
presented 0 5.152 -0.095 -0.0313 3.558 -4.234 
transcribed 6.516 0 -0.222 -0.223 7.161 -5.892 
wp list 0.530 -1.167 0 2.263 0.073 -1.058 
keyboard -5.188 -2.720 -1.258 0 11.233 -5.075 
outside -1.135 -0.740 -0.626 14.165 0 -8.642 

  

N.1.8 Participant 4 

 presented transcribed wp list keyboard outside none 
presented 0 4.600 2.277 4.554 3.509 -9.658 
transcribed 4.617 0 -3.024 -4.144 -3.242 1.774 
wp list 12.753 -5.950 0 -3.881 -5.754 -0.839 
keyboard -3.874 3.715 -1.682 0 7.543 -3.921 
outside -2.257 3.366 -0.155 -1.562 0 0.038 
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N.1.9 Participant e 

 presented transcribed wp list keyboard outside none 
presented 0 6.220 -0.789 -2.472 -2.018 -0.256 
transcribed 11.130 0 -9.350 0.965 11.593 -10.872 
wp list -6.009 1.665 0 -4.527 0.730 4.638 
keyboard -8.265 -8.780 3.556 0 1.290 7.205 
outside 1.846 5.000 4.550 15.683 0 -18.924 

  

N.1.10 Participant 5 

 presented transcribed wp list keyboard outside none 
presented 0 -1.712 -2.734 11.047 10.143 -11.983 
transcribed 8.176 0 -2.561 8.067 5.891 -12.182 
wp list -3.093 -2.801 0 12.211 5.212 -8.866 
keyboard -10.957 0.312 -1.722 0 -9.550 12.023 
outside 11.063 0.315 2.988 16.423 0 -18.271 

  

N.1.11 Participant 6 

 presented transcribed wp list keyboard outside none 
presented 0 -4.619 0.245 -4.733 14.287 -6.288 
transcribed 3.875 0 -1.399 0.797 2.165 -4.859 
wp list 0.760 -2.477 0 0.611 0.220 0.388 
keyboard -12.084 3.427 -2.881 0 -1.449 7.923 
outside 7.868 -2.941 0.761 15.506 0 -16.718 
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APPENDIX O: WITHIN SUBJECT CONSISTENCY BARCHARTS – WITHIN 

KEYSTROKE TYPE 

Participant A: FIX

0

0.05

0.1

0.15

0.2

0.25

0.3

0.35

0.4

0.45

0.5

KN WN KN WN KN TN KN TN

first second third fourth
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Participant A: WPSELECTION

0

0.05

0.1

0.15

0.2

0.25

0.3

0.35

KN WN WK KN WN WK KN WK KN WN

first second third fourth

 

Participant A: LETTER

0

0.05

0.1

0.15

0.2

0.25

0.3

0.35

0.4

KN WN KN WN KN TN KN TN

first second third fourth
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Participant A: SPACE

0

0.05

0.1

0.15

0.2

0.25

0.3

0.35

0.4

KN WN KN WN WK KN TN KN TN

first second third fourth

 

Participant A: TRANSITION

0

0.1

0.2

0.3

0.4

0.5

0.6

0.7

0.8

0.9

1

KN PN KN ON KN KN PN

first second third fourth
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Participant B: FIX

0

0.05

0.1

0.15

0.2

0.25

0.3

0.35

0.4

0.45

TK KN KN TK OT KN TN TK KN TN

first second third fourth

 

Participant B: WPSELECTION

0

0.05

0.1

0.15
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APPENDIX P: WITHIN SUBJECT CONSISTENCY BARCHARTS – ACROSS 

KEYSTROKE TYPE 
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Participant B
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Participant D
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